User’s Guide

RJ-4250WB
RJ-4230B

Before using this printer, be sure to read this User’s Guide.

We suggest that you keep this manual in a handy place for future
reference. ENG



Introduction

Important Notice

B The contents of this document and the specifications of this product are subject to change without notice.
B Unauthorised duplication or reproduction of any or all content of this document is prohibited.

B Brother reserves the right to make changes without notice in the specifications and materials contained
herein and shall not be responsible for any damages (including consequential) caused by reliance on the
materials presented, including but not limited to typographical and other errors relating to the publications.

B Please note that we cannot assume any responsibility for any damage or lost profit arising from the use of
the label created with this printer or the disappearance or change of data due to failure, repair or
consumables using the rechargeable Li-ion battery, or any claim from a third party.

B For servicing, adjustments or repairs, contact Brother customer service or your local Brother dealer.

m |f the printer operates abnormally or any dysfunction occurs, turn the printer off and disconnect each cord
and contact Brother customer service or your local Brother dealer.

B Screen images in this document may differ depending on your version of Windows computer.

B Before using the printer, be sure to read all documents included with the printer for information about safety
and correct operation.

B Not all models are available in all countries or regions.

Trademarks

B Android is a trademark of Google LLC.

B The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any
use of such marks by Brother Industries, Ltd. is under license.

B QR Code is a registered trademark of DENSO WAVE INCORPORATED.
B Epson ESC/P is a registered trademark of Seiko Epson Corporation.
m AirPrint, iPad, iPhone, and iPod touch are trademarks of Apple Inc.

® Wi-Fi® is a registered trademark of Wi-Fi Alliance®.

B Wi-Fi Protected Setup™ is a trademark of Wi-Fi Alliance®.



License

B QR Code Generating Program Copyright © 2008 DENSO WAVE INCORPORATED.

B BarStar Pro Encode Library (PDF417, Micro PDF417, DataMatrix, MaxiCode, AztecCode, GS1
Composite, GS1 Databar, Code93, MSI/Plessey, POSTNET, Intelligent Mail Barcode)

Copyright © 2007 AINIX Corporation. All rights reserved.
H Blue SDK

Copyright © 1995-2018 OpenSynergy GmbH.

All rights reserved. All unpublished rights reserved.

B Portions of this software are copyright © 2014 The FreeType Project
(www.freetype.org). All rights reserved.

Available Manuals

You can download the latest manuals from the Brother support website at support.brother.com.

Product Safety Guide ' 2 This guide provides safety information; read it thoroughly before using your printer.

Quick Setup Guide ' 2 This guide provides basic information about using the printer along with safety
information and detailed troubleshooting tips.

User's Guide 2 This guide includes the contents of the Quick Setup Guide, and additional
information about the printer settings, operations, safety precautions,
communication settings, troubleshooting tips, and maintenance instructions.

Command Reference 2 This manual provides information about printer control commands for controlling
the printer directly.

1 Printed manual in the box.

2 PDF manual on the Brother support website.


http://www.freetype.org
https://support.brother.com

Symbols Used in This Guide

The following symbols are used throughout this guide:

Failure to observe instructions and warnings will result in death or serious injuries.

A DANGER Follow these guidelines to avoid the risk of heat generation, smoking, explosion, or
fire.
Failure to observe instructions and warnings could result in death or serious injuries.
A WARN I NG Follow these guidelines to avoid the risk of heat generation, smoking,explosion, fire,
or injury.

Failure to observe instructions and warnings could result in minor or moderate

A CAUTION injuries.

Follow these guidelines to avoid injury.

Indicates information or directions that should be followed. Ignoring them may result
0 Important in damage, or failed operations.

Indicates notes that provide information or directions that can help you better
‘@ Note P " py
understand and use the product more efficiently.

Important Safety Instructions

ADANGER

Rechargeable Li-ion Battery

H Do not allow the battery to come into contact with liquids.

B Do not charge, use, or leave the battery in high temperature locations (above 60°C).
B Do not attempt to charge the battery using an unsupported charger.

B Use only for its intended purpose.

B Keep away from heat and fire.

B Do not connect the + and - terminals with metal objects such as wire. Do not carry or store the battery with metal
objects.

H Do not throw, hit or damage the battery in any way.
B Do not solder any connections to the battery.
B Do not disassemble or modify the battery.

B Do not dispose of the battery with household waste.




AWARNING

DO NOT use the printer where its use is prohibited, such as on an airplane. This could affect the airplane’s equipment,
resulting in an accident.

DO NOT use the printer in special environments, such as near medical equipment. Electromagnetic waves may cause
the medical equipment to malfunction.

DO NOT allow organic solvents, such as benzene, thinner, nail polish remover, or deodorisers, to come into contact
with the plastic cover. These may cause the plastic cover to warp or dissolve, resulting in an electrical shock or fire.

Printer, AC Adapter (Optional), or Car Adapter (Optional)

B If foreign objects are inserted into the printer or its connectors and ports, stop using the printer and turn the power
off. Then disconnect all cables or remove the battery.

B Do not use, charge and store the product:
* Where liquids may come into contact.
* Where condensation forms.
* Where there is a lot of dust.
* Where the temperature is extremely high.
* During a thunderstorm.
B Do not disassemble or alter the product.
H Do not pour chemicals or use combustible sprays on the product.
B Do not use or store the printer, other components, or packaging within the reach of children.
B Remove the battery or disconnect the cables when shipping.

B If the printer is not in use for long periods, remove the battery or disconnect the cables before storing.

Rechargeable Li-ion Battery

B Keep away from infants. If ingested, contact emergency services immediately.
B Stop using the battery if there are noticeable abnormalities such as smell, heat, deformities, or discolouration.

B If liquid from the battery gets into eyes, wash them immediately with clean water. Contact emergency services
immediately.

AC Adapter, Car Adapter

B Use only with the specified product.
B Insert the plug firmly into the socket.

B Use the AC adapter with standard electrical sockets (AC 100-240 V 50/60 Hz) and the Car adapter with DC 12 V
supplies.

H Do not allow metal objets to come into contact with connectors and ports.

B Do not pull on the cables when disconnecting the AC adapter cord or Car adapter from the electrical socket. Hold
the plug and pull it out of the electrical socket.

B Do not damage, twist, severely bend, pull on, place objects on, bind the AC adapter or Car adapter.
B Do not allow the AC adapter and Car adapter cables to be pinched.

B Do not overload electrical sockets.




ACAUTION

RD Rolls use thermal paper, therefore the colour of the label and the printing may change or fade if exposed to sunlight
or heat. When using outdoors and when durability is important, we DO NOT recommend using RD Rolls.

Depending on the area, material, and environmental conditions, the label may unpeel or become permanently affixed,
and the colour of the label may change or be transferred to other objects. Before affixing the label, check the
environmental conditions and the material. Test the label by affixing a small piece of it to an inconspicuous area of the
intended surface.

Printer

B Do not hold the printer by the RD Roll compartment cover or the roll guide.
There is a risk that the cover could detach or the printer could fall.

B When connecting cables and accessories, follow the applicable instructions.

B Do not touch the print head or metal parts sorrounding the head.

B If the printer is used for a long periods of time, the parts of the printer shown may become hot enough to cause a
low temperature burn.

Rechargeable Li-ion Battery

If liquid from the battery gets onto skin or clothes, immediately rinse with water.

AC Adapter, Car Adapter

Make sure you can always access the cable of the adapter so that you can disconnect itimmediately in an emergency.

Belt Clip

Make sure that the belt clip is attached securely to the printer and the wearer's belt.




ACAUTION

Warning Label

Do not touch the blade or print head.

IMPORTANT

B DO NOT remove the labels affixed to the printer. These labels provide operational information and indicate the
printer's model number.

B DO NOT push the power button or LED indicator with an object that has a sharp point, such as a pen. This could
damage the button or LED.

B DO NOT transport the printer while cables are connected to the DC connector or mini-USB port. The connector and
ports could be damaged.

B DO NOT store the printer in an area exposed to high temperatures, high humidity, direct sunlight, or dust. These
could cause discolouration or a malfunction.




General Precautions

Printer

m If the Bluetooth and wireless LAN functions are both turned on, the communication speed may decrease due to
radio wave interference. If this occurs, turn off the function you are not using (the Bluetooth or wireless LAN
function).

B DO NOT cover or insert foreign objects into the paper exit slot, DC connector, or mini-USB port.

B DO NOT use paint thinner, benzene, alcohol or any other organic solvents to clean the printer. Doing so may cause
damage to the surface finish. You can use isopropyl alcohol or ethanol only when cleaning the print head or roller.
Use a soft, dry cloth to clean the printer.

B When not used for an extended period, remove the roll from the printer.
B Always keep the roll compartment cover closed when printing.

B This printer uses thermal paper. If the printed paper is marked with ink, for example written on or stamped, the ink
may cause the printed text to fade or become discoloured. In addition the applied ink may take some time to dry.
Printed text may fade or become discoloured if the label comes into contact with any of the following: vinyl chloride
products, leather goods such as wallets and purses, organic compounds such as alcohol, ketones, or esters,
adhesive tape, erasers, rubber mats, magic marker ink, permanent marker ink, correction fluid, carbon, glue, diazo
sensitised paper, hand lotion, hair care products, cosmetics, water, or sweat.

B DO NOT touch the printer with wet hands.
B DO NOT use folded, wet or damp paper, otherwise a paper misfeed or malfunction may occur.
B DO NOT touch paper or labels with wet hands, otherwise a malfunction may occur.

RD Roll

. - o (indi RD
Use Brother accessories and supplies (indicated by the mark)

B If the label is affixed to a wet, dirty, or oily surface, it may peel off easily. Before affixing the label, clean the surface
to which the label will be affixed.

B RD Rolls use thermal paper, therefore ultraviolet rays, wind, and rain may cause the colour of the label to fade and
the ends of the label to peel off.

B DO NOT expose the RD Roll to direct sunlight, high temperatures, high humidity, or dust. Store in a cool, dark place.
Use the RD Roll soon after opening the package.

B Scratching the printed surface of the label with your finger nails or metal objects, or touching the printed surface
with hands dampened by water, sweat, or medicated cream etc., can cause the colour to change or fade.

B DO NOT affix labels to people, animals, or plants. Never affix labels to public or private property without permission.

B The last labels of the RD Roll may not be printed correctly, therefore, each roll contains more labels than is indicated
on the package.

B When a label is removed after being affixed to a surface, a portion of the label may remain.
B Once a label is affixed, it may be difficult to remove the label.

Printer, AC adapter, Car adapter, or Accessories

Observe all applicable regulations when disposing of these products.
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Set Up the Printer

Parts Description

0 N O O B~ WDN -

9

Upper tear bar

Lower tear bar

Roll compartment cover

Roll cover release lever

DC connector cover

DC connector

Interface cover

Mini-USB port

Near-Field Communication (NFC) sensor

10 Shoulder strap slots

11 Control panel

See Control Panel on page 14.

12 Charging cradle terminal cover

13 Battery cover (RJ-4250WB/RJ-4230B only)
14 Battery cover latch

15 Belt clip hook

16 Battery compartment

13



Set Up the Printer

Control Panel

1 LED indicator

See LED Indicators on page 17.
2 LCD

See LCD on page 15.

3 t[} (Feed) /OK button
To feed the paper or print the printer settings

4 Menu /¥ (Select) button
5 9 (Back) button

6 (h (Power) button
To turn the printer on/off

14



Set Up the Printer

LCD

When the printer is turned on, the main screen appears.

1 2

G 8

Ry

1 Update icon (RJ-4250WB on

Indicates the FTP connectivity and update status.

©%: There is new data.

ly)

©1 (flashing): Data update failed.

87? (flashing): Cannot connect to the server.

2 Menu key lock icon

Displayed when the [Menu Key Function] in Printer Setting Tool is set to [Disable].

3 Wireless Direct icon (RJ-4250WB only)
Indicates when Wireless Direct is available.

4 WLAN icon (RJ-4250WB only)

- =
% =
e ry

: The printer is connected to the network.

.+2+7T>% ! The printer is searching for the network.

5 Bluetooth icon

Indicates Bluetooth is on. When the icon is flashing, auto re-pairing is in operation (see Auto re-pairing

on page 67).
6 Battery health level icon

When the printer is turned on, the battery health level displayed. It does not appear when charging is not

possible.

Message

Icon

Condition

BatteryHealth Excellent

i

No problems. The battery may be used.

BatteryHealth Good

Still healthy. The battery can be used.

Battery Poor Replace soon

Battery health is deteriorating.

Batt. Very Poor Replace
battery

B
.
U

The battery is badly deteriorated.

15



Set Up the Printer

7 Charge status icon
Displays the charge status of the battery.

® Charging (AC adapter connected): 4

B Not Charging (Battery cannot charge when battery temperature is above 40°C or below 0°C): &
B Not Charging (Charging is finished or paused): No icon is displayed.

8 Battery level
Indicates the remaining battery level.

= Full: [NNEE)
B High: m
= Half: [J1_}
mlow: [}

9 Printer status

16



Set Up the Printer

LED Indicators

The indicator lights and flashes to indicate the printer’s status. The symbols used in this section explain the
meaning of the different indicator colours and patterns:

or

or

or . Indicator is lit in the colour shown

LN i . . .
or -‘- Indicator is flashing in the colour shown
, 1 .

Indicator is off

LED Indicator

Status

Power off
Charging complete (when power is turned off)
No charging (when power is turned off)

Battery level: Half or more
Charging complete (when power is turned on)
Power on (when the battery is not connected but the AC adapter is connected)

No charging (when power is turned on)

Charging

Boot mode

Battery level: low

Sleep mode

17



Set Up the Printer

LED Indicator

Status

Roll end error

Feed error

Cover open error
Communication error
WPS connection error
BLF file error

No template error
Memory full error

ESC/P Memory full error
JPEG file error

Battery deterioration error
Mass storage error
Battery level: empty
System error

Database search error
Battery error (if the battery is not fully charged after the specified amount of time)

Note

If the indicator is lit in

red (Boot Mode), contact your local Brother dealer.

18



Set Up the Printer

Button Functions

() (Power) button function

Operation

Turn the printer on

While the printer is turned off, press the (') (Power) button.

Turn the printer off

While the printer is turned on, press the (') (Power) button until the message
[system Off]appears on the LCD. (If the [Auto Power Off] feature is enabled
in the Device Settings, the printer will turn itself off automatically after the
selected period of inactivity.)

Start the printer in mass storage
mode

If you press and hold the d) (Power) button while also pressing the Menu/¥
(Select) button, the printer starts in mass storage mode (see Mass Storage
Mode on page 92).

9 (Back) button function

Operation

Clear the selected menu item and
return to the beginning.

Press the ©9 (Back) button to return to the previous setting category.

Cancel the current print job.

Press the 99 (Back) button to cancel the current print job.

Menu/
¥ (Select) button function

Operation

Enter the menu selection mode

While the printer is turned on, press the Menu / ¥ (Select) button.

Select the menu option

When the menu is displayed, press the Menu / ¥ (Select) button to select the
next option.

Execute a file stored in the mass
storage area

If you press this button while the printer is running in mass storage mode, you
can execute a command file stored in the mass storage area (see Mass
Storage Mode on page 92).

1Y (Feed)/
OK button function

Operation

Feed the paper

When the paper type is set to [Die-cut Label] or [Media With Marks]:
Press the [ (Feed) /OK button to automatically feed the paper to the print
position.

When the paper type is set to [Continuous Length Tape]:

Press the 1] (Feed) /OK button to feed the paper.

Print the printer information

Make sure that a roll is set, and then press and hold the 1D (Feed) /OK button.
The printer starts printing its settings (see Print the Printer Information
on page 91).

Activate the function mode for the
selected item

Press the [ (Feed) / OK button to activate the selected menu option.

19




Set Up the Printer

Battery Installation/Removal

@ Important
Make sure you charge the rechargeable Li-ion battery (PA-BT-006) either in the printer, or in the charger

before initial use.
Install the Battery
B For RJ-4250WB/RJ-4230B

0 Unlock and pull out the battery cover.

Note

* To remove the battery, reverse the installation procedure.

» Do not lose the battery cover as you will need to reattach it later.

B For RJ-4250WB-L/RJ-4230B-L

0 Unlock and pull out the battery.

20



Set Up the Printer

9 Remove the insulating sheet.

21



Set Up the Printer

Recharge the Battery

While Installed in the Printer

To charge the rechargeable Li-ion battery (PA-BT-006), insert it into the printer and do the following:
Note

» Before using the battery, use the following procedure to charge it.

» Print speed varies with the available battery power.

0 Make sure that the battery is installed in the printer.

9 Use the compatible Brother AC adapter (PA-AD-600) and the AC power cord to connect the printer to
an electrical socket (see How to Recharge the Battery with the AC Adapter (Optional) on page 23), or
use the Brother compatible car adapter (PA-CD-600CG) to connect the printer to a DC power socket
(see How to Recharge the Battery with the Car Adapter (Optional) on page 24).

Note
* The LED indicator light is orange when the battery is charging.

When the battery is fully charged, the LED indicator turns off (when power is turned off) or lights in green
(when power is turned on).

» Charging time is approximately 4 hours. It varies on the environmental conditions.

» Due to the temperature of the battery, charging may stop if the ambient temperature is outside the
following range: 0°C to 40°C.

* The recommended charging temperature range for the battery is from 5°C to 35°C.
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How to Recharge the Battery with the AC Adapter (Optional)

Note

The AC adapter and AC power cord are optional accessories. When purchasing the printer, purchase the
adapter and power cord appropriate for the region where the printer will be used.

By using the AC Adapter, you can use the printer even if the battery is not installed.
0 Open the DC connector cover and connect the AC adapter to the printer.
9 Connect the AC power cord to the AC adapter.

0 Connect the AC power cord to a nearby electrical socket (100 - 240 VAC, 50 - 60 Hz).

1 AC adapter
2 AC power cord

23



Set Up the Printer

How to Recharge the Battery with the Car Adapter (Optional)

Connect the printer to your vehicle’s 12 V DC power socket (cigarette lighter or similar) to charge the
rechargeable battery.

Note

The car adapter is an optional accessory.
The printer will function without a battery installed and external power applied.

0 Connect the car adapter to the vehicle’s 12 V DC power socket.

9 Open the DC cover and connect the car adapter to the printer.

1 Car adapter

How to Recharge the Battery with the Battery Charger (Optional) or Charging Cradle
(Optional)

The battery can be charged using the battery charger (Optional) or Charging Cradle (Optional). For more

information, see Battery Charger (Optional:PA-BC-003) on page 147, or Charging Cradle
(Optional:PA-CR-002) on page 156.
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Stop Battery Charging

To stop the battery charging, disconnect the AC adapter or car adapter from the DC connector.

Tips on Using the Battery

B High density (dark) printing discharges the battery faster than low density printing. You can adjust the print
density setting in the Device Settings (see Device Settings on page 70).

B The battery charging must take place in an environment with a temperature between 0°C and 40°C,
otherwise the battery will not be charged. If the charging stops because the environment temperature is
too low or too high, place the printer in an environment with a temperature between 0°C and 40°C and try
charging again.

B The recommended charging temperature range for the battery is from 5°C to 35°C.

| |f you use the printer when both the battery is installed and the AC adapter or car adapter is connected,
charging may stop even if the battery is not fully charged.

Battery Characteristics
To ensure the highest performance and longest life from the battery:

B Do not use or store the battery in a location exposed to extreme high or low temperatures as it may
deteriorate more quickly.

B Remove the battery when storing the printer for long periods of time.
B Store batteries with less than a 50% charge in a cool dry place out of direct sunlight.
B Recharge the battery every six months if it is stored for long periods of time.

B |tis normal and safe for the printer to become warm while charging. Disconnect the charger and stop using
the printer if it becomes hot to the touch.

B When the printer is turned on, the battery health status is displayed on the LCD.
For battery health status displays, see LCD on page 15.

When not Using the Battery

The printer may be operated without the battery in the following ways:
B When an AC adapter (PA-AD-600) or car adapter (PA-CD-600CG) is connected to the printer.
B When the printer is installed in the Charging Cradle (PA-CR-002).

Note

When the battery is not installed, securely fasten the battery cover with self-tapping screws (M2.6 x 6 mm)
(not included).
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Power On or Off

On: Press the (V) (Power) button.

Off: Press the (') (Power) button until the message [System Off] appears on the LCD.

Note

* When the printer is connected to the AC adapter, power turns on automatically by default.

* Do not remove the battery until the LCD turns off when the AC adapter is not connected to the printer and
the electrical socket.

Set the Language

0 Press the Menu / ¥ (Select) button to select the [Set tings] menu, and then press the 1] (Feed) / OK
button.

9 Select [[:J Language] , and then press the [ (Feed) / OK button.
0 Select a language, and then press the t[% (Feed)/ OK button.

Insert the Roll

0 Push the roll cover release lever to open the roll compartment cover.

1 Roll cover release lever
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@ Slide both roll guides outwards.

@ Insert the roll.

1 Print surface (faces outwards on the roll)

0 Close the roll compartment cover until it locks.

@ Important
For best performance, use genuine Brother RD rolls.
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Note

« When using die-cut labels, set the paper type to [Die-cut Label], and press the 1[" (Feed)/ OK button after
inserting the roll. The printer will feed the label to the top of form position.

» To remove the roll, reverse the installation procedure.
» Make sure inserted rolls turn correctly.
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Use of Roll Holder Locks

Install roll holder locks to securely fix the roll guide. Roll holder locks can be combined to achieve one of four

different roll widths, as follows:

Roll Width Roll Holder Lock | Roll Holder Lock | Roll Holder Lock Combina_tion
1 2 3 lllustration
105.6 mm ‘/ — — A
101.6 mm V — V B
84 mm ‘/ ‘/ — C
80 mm ‘/ ‘/ ‘/ D

Combinations (L/R Symmetrical)

Combinations (L/R Symmetrical)

Roll Holder Lock 1

Roll Holder Lock 1+ Roll Holder Lock 2

|
0k,
4

Roll Holder Lock 1+ Roll Holder Lock 3

Lock 3

Roll Holder Lock 1+ Roll Holder Lock 2 + Roll Holder
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B Use roll holder lock 2 by installing it with the included screws provided with roll holder lock 1.

B Use roll holder lock 3 by attaching it to roll holder lock 1 or roll holder lock 2 with double-sided tape.

roll holder lock 3 comes with double-sided tape attached in three locations. Make sure you remove the
paper backing from the double-sided tape before using it for the first time.

@ !mportant
Always install the left and right roll holder lock in the same configuration on both sides.

Incorrectly secured rolls may dislocate and damage the printer.

Install the Roll Holder Lock

0 Fasten the claw hook of roll holder lock 1 in the roll guide hole.

9 Push down the roll holder lock.

3
-
4
2
)
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Tear Off Media

Receipt paper, labels, and tags can be torn off by swiftly pulling up or down on the media according to the set
cutting position. Linerless media can only be torn upwards.

1 Lower tear bar
2 Upper tear bar

A CAUTION

Do not touch the blade.

Note

* The [Tear Bar] is set in the [Upward] position at the time of purchase. (When [Linerless] to [On] in the
[Advanced] tab of the Printer Setting Tool, the [Tear Bar] cannot be selected.)

» To adjust the cutting position, open the Printer Setting Tool, and go to [Print Position / Sensor] in the
[Device Settings], and then enter the setting you want in the [Tear Adjust] field. For more information,
see Print Position / Sensor on page 78.
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Attach the Belt Clip

You can carry the printer on your belt by attaching and using the included belt clip. Follow the instructions
below to attach the clip to the printer and to your belt. After attaching the clip to the printer, you can attach
and secure it to your belt.

0 Attach the belt clip to the belt clip hook on the printer, as shown:

1 Belt clip hook

9 Attach the clip to your belt.

@ !mportant
» Make sure you attach the belt clip securely to the printer.

» To detach the belt clip, reverse the installation procedure.
* We recommend using a belt that is less than 5 mm thick and width is less than 47.63mm.
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Install Software on Your Windows Computer or Mobile Device

Several printing methods are available, depending on the printer model and the computer or mobile device

you use to print from.

See the following tables and install other software on your computer or mobile device as needed.

Available Software

For computer

To use the printer with your computer, you must install the printer driver.

Software

RJ-4250WB

RJ-4230B

Features

1 | Printer driver

4

v

Communication
Settings

v

v

Device Settings

v

v

Allows you to specify the printer's communication
settings and device settings from the computer.

Printer
2 | Setting | P-touch
Tool Template

Allows you to configure the P-touch template settings.

P-touch Template provides functions for inserting data
from a device (such as a barcode reader connected to

Settings the printer) into text and barcode objects in layouts
saved on the printer, useful for printing templates and
barcodes.

Paper Size V ‘/ Allow you to add the paper sizes not available in the

Setup [Paper Size] list of the printer driver.

3 | P-touch Editor

<

AN

Allows you to:
B Store custom documents as template data.

B Use alarge library of labels and tags by connecting
to the database.

P-touch Transfer
Manager

Allows you to transfer files created with P-touch Editor
to a printer and store the files in the printer's memory.
You can print them from the printer's memory without
connecting to your computer.

5 | P-touch Library

Allows you to manage and print P-touch Editor
templates.

6 | P-touch Transfer Express

Allows you to transfer documents to the printer.

7 | P-touch Update Software

SNIN] S

Allows you to update the firmware and software.

8 | BRAdmin Professional

S SIKIXN| KX

BRAdmin Professional has more powerful features for
managing network printers than BRAdmin Light. You
can configure and check the status of your network
connected printers, and transfer the template to the
printer via a network.
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Software

RJ-4250WB

RJ-4230B

Features

9

BRAdmin Light

v

Allows you to configure the initial settings of network
connected printers.

Allows you to manage printers on different local
networks* and send data to the computer on which
BRAdmin Professional is installed.

10 | BRAgent ‘/ —
* A local network is the area managed by a single
router.

11 | Web Based Management ‘/ . Allows you to use a standard web browser to manage

a printer on your network using HTTP.

12

Font Manager

Allows you to transfer fonts to the printer and delete
fonts from the printer.

Transferred fonts can be accessed and printed using
various print commands.

B About font usage permission

When using fonts, you must abide by all terms and
conditions set forth by each rightful font owner.
Before downloading fonts, you must confirm that
you have legitimate licences to use the fonts and
comply with their terms and conditions; otherwise
you may not download fonts.

For mobile devices

Software

RJ-4250WB

RJ-4230B

Features

Mobile Transfer Express

4

v

Allows you to use a mobile device to transfer files
(templates, databases and images) which were
prepared using P-touch Transfer Manager (Windows
version), to a printer.

Allows you to print from an Apple device (iPad,

AirPrint . . : . : "
2 (For Apple device) V — ;erwtc\)’c]:réor iPod touch) without installing additional
Allows you to use a standard web browser to manage
3 | Web Based Management V T a printer on your network using HTTP.
4 Print Service Plugin Allows you to print from an Android device without
(Android) v v installing additional software.
Allows you to perform updates for the settings and
firmware of printers in the field using a mobile device.
5 | Mobile Deploy V ‘/ This software will send printer update files pre-

uploaded to DropBox or an Http(s) server to target
printers.

A software development kit (SDK) is also available.

To obtain the SDK and Font Manager, visit the Brother Developer Center (www.brother.co.jp/eng/dev/).
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Install the Printer Driver and Software (When Using a Computer)

To print from your computer, install the printer driver, P-touch Editor and other software on your computer.
Visit our website (install.brother) and download the installer for the software and manuals.
When a serial number is requested, see the base of the printer and enter the number.
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Connect the Printer to a Computer or Mobile Device

Connect the printer using one of the methods below:
m USB cable connection (computer only)
See Connect Using USB (Computer Only) on page 36.
B Bluetooth connection
See Connect Using Bluetooth on page 37.
B Wireless LAN connection (RJ-4250WB only)
See Connect Using Wi-Fi (RJ-4250WB Only) on page 38.
B NFC connection (Android)
See Connect Using NFC (Android) on page 42.

Connect Using USB (Computer Only)

0 Before connecting the USB cable, make sure that the printer is turned off.

9 Connect the printer end of the USB cable to the mini-USB port on the side of the printer.

0 Connect the other end of the USB cable to the USB port on the computer.

0 Turn the printer on.
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Connect Using Bluetooth

Note

Follow the manufacturer's recommendations for your Bluetooth-equipped devices (computers and mobile
devices) or Bluetooth adapter, and install any necessary hardware and software.

Use this procedure to pair the printer with the computer using the Bluetooth management software.

0 Press the Menu/¥ (Select) button to select the [Bluetooth] menu, and then press the 1]} (Feed) / OK
button.

9 Select [on/0f £] and then press the t[") (Feed) / OK button.
Select [0on].

0 Use your Bluetooth management software to discover the printer.
Select the printer where XXXX is the last four digits of the printer's serial number. You can find the serial
number label on the base of the printer.
Bluetooth communication is now available.

Note

* You can also change the printer's communication settings using the Communication Settings (see
Communication Settings on page 51).

* By default, Bluetooth mode is setto [Classic & LE], so two identical Bluetooth names (for Classic and
Low Energy) might be displayed in the Bluetooth menu of your Android device.
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Connect Using Wi-Fi (RJ-4250WB Only)

The following Wi-Fi connection methods are available:
B Wireless Direct

B Infrastructure Mode

B Infrastructure Mode + Wireless Direct

m WPS (Wi-Fi Protected Setup™)

Wireless Direct
Wireless Direct allows you to connect the printer to your computer or mobile device directly without a Wi-Fi
access point/router; the printer serves as a Wi-Fi access point.
0 Confirm the Wireless Direct settings of the printer.
B Using the printer
1 On the printer, press the Menu/ ¥ (Select) button to select the [WL.AN] menu, and then press the
1[N (Feed) / OK button.

2 Press the Menu/ ¥ (Select) button to select the [Mode] menu, and then press the t[} (Feed) / OK
button.

3 Select [Direct], and then press the 1] (Feed) / OK button. The Wireless Direct icon appears on
the LCD.

B Using a computer

Connect the printer and computer with a USB cable. Start the Printer Setting Tool on your computer,
and click the [Communication Settings] button. Confirm that [Wireless Direct] is selected for
[Selected Interface] in the [General] tab.

See Communication Settings on page 51 for more information on the Communication Settings.
9 On the printer, press the Menu/ ¥ (Select) button to select the [WLAN] menu, and then press the

t[™ (Feed) / OK button.
Set [On/0ff] to [On].

0 Use your computer or mobile device to select the SSID of the printer ("DIRECT-*****_RJ-4250WB"). If
required, enter the password ("425*****"). ***** is the last five digits of the serial number.

Note

* You can change the printer’s network settings using the Printer Setting Tool (see Change the Printer
Settings on page 48).

» The Printer Setting Tool also allows you to apply the network settings changes to multiple printers. (See
Apply Setting Changes to Multiple Printers on page 69.)

* You can find the serial number label on the base of the printer.

You can also confirm the serial number by printing the printer information (see Print the Printer Information
on page 91).
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* You cannot connect to the Internet via Wi-Fi while using Wireless Direct. To use the Internet, connect using
Infrastructure Mode.

Infrastructure Mode

Infrastructure Mode allows you to connect the printer to a computer or mobile device via a Wi-Fi access
point/router.

H Before You Begin

First you must configure the Wi-Fi settings of the printer to communicate with your Wi-Fi access
point/router. After the printer is configured, computer or mobile devices on your network will have access
to the printer.

@ Important

+ If you are going to connect the printer to your network, we recommend that you contact your system
administrator prior to installation. You must confirm your Wi-Fi settings before you proceed with this
installation.

» To configure the Wi-Fi settings again, or if the status of the printer's Wi-Fi connection is unknown, reset
the Wi-Fi settings of the printer.

1 Press the () (Power) button to turn the printer off.

2 Press and hold the t[3 (Feed) / OK button and the (!) (Power) button for about five seconds. The LED
indicator starts blinking in green.

3 While pressing the () (Power) button, press the t[* (Feed) / OK button twice.
4 Release the () (Power) button.

Note

To achieve the best results with normal everyday document printing, use the printer as close to the Wi-Fi
access point/router as possible with minimal obstructions. Large objects and walls between the two
devices as well as interference from other electronic devices can affect the data transfer speed of your
documents.

B Connect the printer to your Wi-Fi access point/router

0 First, write down the SSID (network name) and password (network key) of your Wi-Fi access
point/router.

9 Connect the printer and computer with a USB cable.

0 On the printer, press the Menu/ ¥ (Select) button to select the [WL.AN] menu, and then press the
t[™ (Feed) / OK button.
Set [on/0ff] to [On].
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e Configure the Infrastructure Mode settings of the printer.
B Using the printer
1 On the printer, press the Menu/ ¥ (Select) button to select the [WL.AN] menu, and then press the
1[N (Feed) / OK button.

2 Press the Menu/ ¥ (Select) button to select the [Mode] menu, and then press the 1" (Feed) /
OK button.

3 Select[Infrastructure], and then press the t[3 (Feed) / OK button.
B Using a computer

Start the Printer Setting Tool on your computer, and click the [Communication Settings] button.
Select [Wireless LAN] for [Selected Interface] in the [General] tab, and select [Infrastructure]
for [Communication Mode] in [Wireless Settings] in the [Wireless LAN] tab.

See Communication Settings on page 51 for more information on the Communication Settings.
@ Start the Printer Setting Tool on your computer, and click the [Communication Settings] button.

Select [Wireless Settings] in the [Wireless LAN] tab.
Enter the SSID that you wrote down, or click [Search] and select the SSID from the displayed list.

@ Enter the password as [Passphrase].

Note

The required information depends on the authentication method and encryption mode; enter only the
information relevant to your network environment.

@ ciick [Apply].
When the connection between the printer and your Wi-Fi access point/router is established, the

= (Wi-Fi) icon appears on the printer's LCD. Computers and mobile devices that are on the same
network as the printer will have access to the printer.

Note

» To change any other network settings, use the Printer Setting Tool (see Change the Printer Settings
on page 48).

» To connect your mobile device to the Wi-Fi access point/router, select the SSID and enter the password
of the Wi-Fi access point/router to establish the connection between the mobile device and Wi-Fi access
point/router.

Infrastructure Mode + Wireless Direct
Infrastructure Mode and Wireless Direct can be used at the same time.
B Use the printer

0 On the printer, press the Menu/ ¥ (Select) button to select the [WL.AN] menu, and then press the
[ (Feed) / OK button.

9 Press the Menu/ ¥ (Select) button to select the [Mode] menu, and then press the [ (Feed) / OK
button.
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0 Select [Direct/Infral, and then press the 1% (Feed) / OK button.
B Using a computer

0 Start the Printer Setting Tool on your computer, and click the [Communication Settings] button.

9 Select [Infrastructure and WirelessDirect] for [Selected Interface] in the [General] tab.
See Communication Settings on page 51 for more information on the Communication Settings.

WPS (Wi-Fi Protected Setup™)
If your Wi-Fi access point/router supports WPS, settings and connections can be configured quickly.

0 First, confirm that your Wi-Fi access point/router has the WPS symbol.

9

Place the printer within the range of your Wi-Fi access point/router. The range may differ depending on
your environment. See the instructions provided with your Wi-Fi access point/router.

Press the WPS button on your Wi-Fi access point/router.

On the printer, press the Menu/ ¥ (Select) button to select the [WL.AN] menu, and then press the
t[™ (Feed) / OK button.

Press the Menu/ ¥ (Select) button to select the [WPS] menu, and then press the 1] (Feed) / OK button.

Q0 006 o

Select [Button Push]or[PIN Code], and then press the t[} (Feed) / OK button.
For details, see the instructions provided with your Wi-Fi access point/router.

When the connection is established, the WLAN icon appears on the printer's LCD. Computers and mobile
devices that are on the same network as the printer will have access to the printer.

Note

» The printer will try to connect using WPS for two minutes. If the Menu/ ¥ (Select) button is pressed during
that time, the printer will continue trying to connect for an additional two minutes.

« If your computer or mobile device supports the PIN authentication method, select [PIN Code] for better
security.
How to confirm your printer's IP address

0 On the printer, press the Menu/¥ (Select) button to select the [WL.AN] menu, and then press the
t[™ (Feed) / OK button.

9 Press the Menu/¥ (Select) button to select the [TP Address] menu, and then press the [ (Feed) / OK
button.
The LCD displays the IP address and SSID (Network Name) for Wireless Direct or Infrastructure Mode.
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Connect Using NFC (Android)

Confirm that the printer's Bluetooth settings and the mobile device's Bluetooth and NFC settings are all set
to ON, and touch your mobile device to the printer.

Note

* The printer's Bluetooth mode must be setto [Classic & LE]or[Classic].[Low Energy]is not
supported.

* NFC compatibility with your Android device cannot be guaranteed.
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LCD

LCD Settings

Specify Settings from the Computer

You can specify the LCD settings either by using the printer, or by using the Printer Setting Tool on a
computer connected to the printer. For more information about connecting a computer and specifying
settings, see Change the Printer Settings on page 48.

Specify Settings from the Printer

Press the Menu/ ¥ (Select) button to select a menu option, and then press the t[%) (Feed) / OK button. Press
the Menu/¥ (Select) button to select an option, and then press the t[3 (Feed) / OK button.

2

2 The scroll bar indicates the first parameter with the up arrow, and the last parameter with the down arrow.
If the last parameter is selected, pressing ¥ (Select) button scrolls back to the first parameter.

B Set the Media Size

FlLanguage
LCD Contrast >

1 The currently selected option is highlighted.

0 Press the Menu/ ¥ (Select) button to select the [Media] menu, and then press the OK button.

9 Select [Select Medial, and then press the OK button.
B Detect the Media Size
The die-cut media can be detected automatically.

0 Set the die-cut media in the printer.

9 Press the Menu/ ¥ (Select) button to select the [Media] menu, and then press the t[% (Feed) / OK
button.

0 Select [Auto Detect], and then press the 1% (Feed) / OK button.

Note

If the media size cannot be detected, set the media size from [Select Medial.
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B Set the LCD Contrast

0 Press the Menu/ ¥ (Select) button to select the [Settings] menu, and then press the t[%) (Feed) /

OK button.

9 Select[LCD Contrast], and then press the t[3 (Feed)/ OK button. Select the option, and then press

the t[" (Feed) / OK button.
B Set the Beeper
Select whether the printer beeps at startup, shutdown and error.

0 Press the Menu/ ¥ (Select) button to select the [Settings] menu, and then press the t[%) (Feed) /

OK button.

9 Select [Beeper], and then press the [ (Feed) / OK button. Select the option, and then press the

t[™ (Feed) / OK button.
B Bluetooth Functions

[on/0f f]: To connect the printer and your Bluetooth-equipped devices, see Connect Using Bluetooth
on page 37.

[Mode]: Bluetooth mode can be selected from [Classic & LE], [Classic], or [Low Energyl].

[AutoReconnect]: Automatically reconnects to a previously connected to iOS supported devices
including iPhone, iPad and iPod touch.

[Clear History]: Deletes information for auto re-paired devices registered in the printer.
[BT Address]: The Bluetooth address of the printer appears on the display.

[Print Barcode]: The Bluetooth address and corresponding barcode (width:42 mm) can be printed.

Note

When printing large print jobs, set the Bluetooth mode to [Classic].

® Wi-Fi Options (RJ-4250WB only)

For connection methods and settings using the Wi-Fi function, see Connect Using Wi-Fi (RJ-4250WB
Only) on page 38.

[on/0f f]: Connect your printer to a wireless device.

[Mode]: Select a wireless connection mode.

Available settings: [Direct], [Infrastructure], [Direct/Infra]l

[wps]: Set up a WPS connection.

[WLANAssistant]: This function might be needed while installing the driver.
[TP Address]: View the printer's IP address and SSID (Network Name).
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B Remote Update (RJ-4250WB only)

Connect to the FTP server and download new templates, databases, and other files. Set the information
of the FTP server in advance using [Communication Settings] in the Printer Setting Tool. For more
information, see Communication Settings on page 51.

This item appears when the FTP server is set and updated files are available.

0 Press the Menu/ ¥ (Select) button to select the [Update] menu, and then press the 1] (Feed) / OK
button.

9 Select [start], and then press the [ (Feed) / OK button.
When the update starts, [Receiving] or [Downloading] appears on the LCD.
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Print from Windows Computer

Printing with the Printer Driver

0 Open the document you want to print.

9 Connect the printer to a computer using USB, Bluetooth or Wi-Fi (see Connect the Printer to a Computer
or Mobile Device on page 36).

Note

If necessary, change the printer settings in the printer driver’s dialog box, or in the Printer Setting Tool (see
Change the Printer Settings on page 48).

9 Print from the software.
The message [Printing] appears onthe LCD. When printing is finished, the printer reverts to the mode
selected before printing started.

Note

To print a JPEG image without using the printer driver, see Print JPEG Images on page 93.

Make Prints Lighter or Darker

You can make prints lighter or darker by adjusting the print density setting in the Device Settings (see Device
Settings on page 70).

When using the battery, changing the print density setting may result in slight changes in printing speed and
the number of pages that can be printed on a single charge.

Set Printer Driver Options

You can configure various settings such as paper size and number of copies, in the printer driver screen.

Note

You can also use the Printer Setting Tool (see Change the Printer Settings on page 48) to configure
advanced settings.
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Custom Printing from Mobile Devices

A software development kit (SDK) is available.
Visit the Brother Developer Center (www.brother.co.jp/eng/dev/).

You can print from your mobile device using AirPrint (RJ-4250WB only).

For more information, see the AirPrint Guide. Visit your model's Manuals page on the Brother support website
at support.brother.com to download the guide.
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Change the Printer Settings

Printer Setting Tool

Using the Printer Setting Tool, you can specify the printer’'s communication settings, operation settings,
P-touch template settings and paper size settings from Windows computer.

Note

The Printer Setting Tool is installed automatically when you use the installer to install the printer driver. For
more information, see Install Software on Your Windows Computer or Mobile Device on page 33.

@ Important
The Printer Setting Tool is available only with compatible printers.

Before Using the Printer Setting Tool

B Make sure that the printer is connected to an electrical socket and turned on.
B Make sure the printer driver has been installed correctly and you can print.

B Connect this printer to a computer with a USB cable. This tool cannot be used to configure printers
connected to a wireless network.
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Use the Printer Setting Tool

0 Connect the printer you want to configure to the computer.

9 Start the Printer Setting Tool.
B For Windows 10 / Windows Server 2016 (RJ-4250WB):
Click [Start] > [Brother] > [Printer Setting Tool].
The main window appears.

B For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2
(RJ-4250WB):

Click the [Printer Setting Tool] icon on the [Apps] screen.
B For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB):
Click [Start] > [All Programs] > [Brother] > [Label & Mobile Printer] > [Printer Setting Tool].

I[§ Printer Setting Tool

Specify advanced settings for the selected printer.

1 ——Printer: ‘Brother R1-4230B =

Communication Settings
=3 Specify wired LAN, wireless LAN and Bluetooth communication settings.
(=

Communication Settings... |—*2

Device Settings

- Specify settings related to the printer operation, such as power settings, print
1 U settings, and printer maintenance.

Device Settings... |—* 3

P-touch Template Settings

H Specify P-touch Template settings.
1 P-touch Template is a function for transferring text data from a connected
device into objects in a template saved on the printer.

P-touch Template Settings... |—*4

Paper Size Setup

A In order to use a size not listed in the "Format” list of the printer driver,
_._ﬂ add a paper format to the printer driver.

| 1) Paper Size Setup... |—*5

| it ——6

1 Printer
Lists the connected printers.
2 Communication Settings
Specifies the wireless LAN (RJ-4250WB only) and Bluetooth communication settings.
3 Device Settings
Specifies printer operation settings, such as power settings and printer settings. Settings can also
be specified for the LCD.
4 P-touch Template Settings
Specifies P-touch template settings.

For more information on P-touch Template, download the P-touch Template Manual/Command
Reference (English only) from the Brother support website at support.brother.com.
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5 Paper Size Setup

Add media information and settings to the printer driver to use sizes not listed in the [Paper Size]
list of the printer driver.

@ Important
To open [Paper Size Setup], you must be logged on with administrator rights.

6 Exit
Closes the window.

Check that the printer you want to configure appears next to [Printer]. If a different printer appears, select
the printer you want from the drop-down list.

Select the setting you want to change, and then specify or change the settings in the dialog box.
For more information on the settings dialog boxes, see Communication Settings on page 51, Device
Settings on page 70, P-touch Template Settings on page 82, or Paper Size Setup on page 85.

@ Click [Apply] - [Exit] in the settings dialog box to apply the settings to the printer.
@ Click [Exit] in the main window to finish specifying settings.
o

Important

Use the Printer Setting Tool to configure the printer only when the printer is in standby. The printer may
malfunction if you try to configure it while it is handling a job.
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Communication Settings

With [Communication Settings] in the Printer Setting Tool, the printer communication information can be
specified or changed when connecting the printer and computer with a USB cable or via a Bluetooth
connection. Not only can you change the communication settings for one printer, but you can also apply the
same settings to multiple printers.

Settings Dialog Box

File Tools Help
l Printer: ‘Brnther R1-4250W8B - H Wireless LAN Node Name: 3000000000000
Bluetooth Device Name: XX-XOO0_XXXX . 5
[ senerl [ wrsless an | & wireless Drect | i sstootn | —— 6
1 7] Disable these settings
Current Status
Communication Settings The current status wil be displayed.
- 1Pv6
. Network Settings on Power On: Keep Current State
Rfrrigte Update Bluetooth on Power On: Keep Current State
& Selected Interface: Wireless Direct
IPv6 usage: Enable
Priority on IPv6 address: OFF
CA Certfficate: Not Installed
Client Certificate: Not Installed
[Remote Update]
Update ID: NONE 7
2 | TP Address of FTP server: NONE
T ks
sy |w Exit
| |

1 Disable these settings

When this check box is selected, Lﬁ’b appears in the tab, and the settings can no longer be specified or
changed.

Settings in a tab where Lﬁ’& appears will not be applied to the printer even if [Apply] is clicked. In addition,

the settings in the tab will not be saved or exported when the [Save in Command File] or [Export]
command is executed.

To apply the settings to the printer or save or export them, make sure you clear the check box.

2 Items
When [Current Status] is selected, the current settings appear in the settings display/change area.
Select the item for the settings that you want to change.

3 Menu Bar

4 Printer
Lists the connected printers.
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5 Node Name/Bluetooth device name
Displays the node name (nodes can be renamed) and Bluetooth device name. (See 7 Change Node
Name/Bluetooth Device Name in Menu Bar on page 53.)

6 Settings Tabs
Contains settings that may be specified or changed.

If ﬁ’& appears in the tab, the settings in that tab will not be applied to the printer.

7 Settings Display/Change Area

Displays the current settings for the selected item.
8 Refresh

Updates the displayed settings with the most recent information.
9 Apply

Applies the settings to the printer.

To save the specified settings in a command file, select [Save in Command File] from the drop-down list.
The saved command file can be used with the mass storage mode to apply the settings to a printer. (See
Mass Storage Mode on page 92.)

@ Important
Clicking [Apply] applies all settings in all tabs to the printer.
If the [Disable these settings] check box is selected, the settings in that tab are not applied.

10 Exit
Exits [Communication Settings], and returns to the main window of the Printer Setting Tool.

@ Important
Changes to settings are not applied to printers if you click [Exit] without first clicking the [Apply] button.
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Option Settings
[¥] Automaticall restart the printer after applying new settings

Menu Bar

1 Apply Settings to the Printer

2 Save Settings in Command File...

3 Install Certificates...

4 Impaort...

5 Export...

Exit
el
Option Settings...

8 Change Node Name/Bluetooth Device Name...
9 Reset to Default Communication Settings...

Display Help F1

About...

1 Apply Settings to the Printer
Applies the settings to the printer.

2 Save Settings in Command File

€ The specified settings are not applied until the printer is restarted.

Automaticaly detects the connected printer, and retrieves the current settings

oK | [ caneal |

Saves the specified settings in a command file. The file extension is .bin.
The saved command file can be used with the mass storage mode to apply the settings to a printer. (See

Mass Storage Mode on page 92.)

Note

If the [Disable these settings] check box is selected, the settings in that tab are not saved.

@ 'mportant

» The following information is not saved with the command file:

* Node name

+ IP address, subnet mask and default gateway (when the IP address is set to [STATIC])

» The saved communication settings commands are intended to be used only for applying settings to a
printer. To apply the settings to the printer using this command file, use the mass storage mode.

+ Saved command files contain authentication keys and passwords. We recommend storing command files

only if necessary.

* Do not send the command file to a different printer model.
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3 Install Certificates (RJ-4250WB only)
Some network authentication methods may require a certificate.
Install a certificate on the connected printer or save a certificate as a command file that can be distributed
to the same model printers.
4 Import
B Import from the current computer wireless settings
Imports the settings from the computer.

Note

* When importing the wireless settings, administrator privileges for the computer are required.

» Only personal security authentication settings (open system, public key authentication and
WPA/WPA2-PSK) can be imported. Enterprise security authentication (such as EAP-FAST), WPA2-PSK
(TKIP) and WPA-PSK (AES) settings cannot be imported.

* If multiple wireless networks are enabled on the computer, only the personal settings that are detected first
will be imported.

* Only the settings from the [Wireless LAN] tab - [Wireless Settings] pane can be imported
(communication mode, SSID, authentication method, encryption mode and authentication key).

B Select a Profile to import
Imports the exported file and applies the settings to a printer.

Click [Browse] and select the file you want to import. The settings in the selected file appear in the
settings display/change area.

Note

+ All settings (such as wireless settings or TCP/IP settings) can be imported, except for node names.
* Only the profiles compatible with the selected printer can be imported.

« If the imported profile’s IP address is set to [STATIC], change the IP address of the imported profile, if
needed, so that it does not duplicate the IP address of an existing printer on the network.

5 Export
Saves the current settings in a file.

Note

If the [Disable these settings] check box is selected, the settings in that tab are not saved.

@ Important
Exported files are not encrypted.

6 Automatically restart the printer after applying new settings
If this check box is selected, the printer automatically restarts after communication settings are applied.
If this check box is cleared, your must restart the printer manually.
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Note

When configuring multiple printers, you can reduce the time needed to change settings by clearing this
check box. In this case, we recommend selecting this check box when configuring the first printer so that
you can confirm that each setting is operating as intended.

7 Automatically detects the connected printer, and retrieves the current settings

If this check box is selected and a printer is connected to the computer, the printer is automatically
detected and the printer’s current settings are displayed in the [Current Status] pane.

Note

If the model of the connected printer is different from that of the printer shown in the [Printer] drop-down
list, the settings available on all tabs change to match the connected printer.

8 Change Node Name/Bluetooth Device Name
Allows renaming a node and Bluetooth device.

9 Reset to Default Communication Settings

Returns the communication settings to their factory settings.
10 Display Help

Displays the Help.
11 About

Displays the version information.
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General Tab

Communication Settings

4 Communication Settings - General > Communication Settings (=]
File Tools Help

Printer: |Bmther RI1-4250WB " Wireless LAN Node Name: JoOO0000000CO00C
Bluetooth Device Name: XX-XXXX_JO00¢

General | Wireless LAN | Wireless Direct | Bluetooth |

[7] Disable these settings

- Current Status

[® Communication Settings Specify the settings for the communications device to be used.

- Pve

i Remote Update Wireless LAN

‘Log T

Network Settings on Power On: |Keep Current State - 1
Selected Interface: Wireless Direct v 2
Bluetooth
Bluetooth on Power On: Keep Current State - 3

1 Network Settings on Power On (RJ-4250WB only)

Specifies the conditions for connecting via Wi-Fi when the printer is turned on.

Available settings: [On by default], [Off by default], [Keep Current State]
2 Selected Interface (RJ-4250WB only)

Available settings: [Infrastructure], [Infrastructure and Wireless Direct], [Wireless Direct]
3 Bluetooth on Power On

Specifies the conditions for connecting via Bluetooth when the printer is turned on.

Available settings: [On by default], [Off by default], [Keep Current State]
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IPv6 (RJ-4250WB only)

4 Communication Settings - General > IPv6 ==
File Tools Help

Printer: |Eruther R1-4250WB " Wireless LAN Node Name: JoOO0000000CO00C
Bluetooth Device Name: XX-XXXX_JO00¢

General | Wireless LAN | Wireless Direct | Bluetooth |

[7] Disable these settings

+ Current. Status

- Communication Settings Specify the IPv6 settings.

-Log -
[Tl Priority on IPv6 address

fesbvml v

1 IPv6 usage
Available settings: [Enable], [Disable]
2 Priority on IPv6 address
Select to give priority to an IPv6 address.
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Remote Update (RJ-4250WB only)

4 Communication Settings - General » Remote Update ==
File Tools Help

Printer: [Bmther R1-4250WB '] Wireless LAN Node Name: JXOO0000000CO00C
Bluetooth Device Name: XX-XXXXX_JO00¢

General \W\re\ass LAN IWira\ess Direct | Bluetaoth\
[T Disable these settings
¢ Current Status
- Communication Settings Please specify FTP connection details for Remote Update.
- Pv6
R& Remote Update 1P Address of FTP server: 1
-Log
21 2
PASV Mode
Display the key and password on-screen
updateinfo.ini 6

oy |~

1 IP Address of FTP server
Type the FTP server address.

2 Port
Specifies the port number used to access the FTP server

3 User name
Type a user name that has permission to log in to the FTP server.
4 Password
Type the password associated with the user name you entered in the Username field.
5 Path
Type the path to the folder on the FTP server where you want to download the update file from.
6 Setting file name
Specifies the update file name on the FTP server.
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B Log

4 Communication Settings - General > Remote Update > Log ==
File Tools Help

Printer: [Bmther R1-4250WB '] Wireless LAN Node Name: XXXXO00O0000000(
Bluetooth Device Name: XX-X000C XXXX

General | Wireless LAN | Wireless Direct | Bluetooth |

[7] Disable these settings

¢ Current Status
+ Communication Settings

Specify the update log setting.

Pvb
i Remote Update Log storage: Enable - 1
Lo}
Log storage path of FTP server:  /log 2

oy |

1 Log storage
Select whether to export the update log to the FTP server.
Available settings: [Enable], [Disable]

2 Log storage path of FTP server
Type the path to the folder on the FTP server where you want to export the log data.
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Wireless LAN Tab (RJ-4250WB Only)

TCP/IP (Wireless)

-4 Communication Settings - Wireless LAN > TCP/IP(Wireless) ==
File Tools Help
Printer: ‘Brnther R1-4250WB 'J Wireless LAN Node Name: JXOO00CBO00CG0X
Bluetooth Device Name: XX-XXXX_XXXX
General | Wireless LAN | Wireless Direct | Buetooth |
[ Disable these settings
Current Status
TCP/IP(Wireless) Specify the TCP/IP settings used with the wireless network. —— ’]
i PvG
1P Add
- Wireless Settings ress S
Boot Method: AUTO A
DNS Server
DNS Server Method: AUTO = T 3

1 Boot Method

sy |w Exit

Available settings: [AUTO], [BOOTP], [DHCP], [RARP], [STATIC]

2 |P Address/Subnet Mask/Gateway

You can type these settings only when the IP address is set to [STATIC].

3 DNS Server Method
Available settings: [AUTO], [STATIC]

4 Primary DNS Server IP Address/Secondary DNS Server IP Address
You can type these settings only when the DNS server is set to [STATIC].
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IPv6

4 Communication Settings - Wireless LAN > TCP/IP(Wireless) > IPv6 =]
File Tools Help

Printer: [Bmther R1-4250WB '] Wireless LAN Node Name: JoOO0000000CO00C
Bluetooth Device Name: XX-XXXXX_ 000

General | Wireless LAN | Wireless Direct | Bluetooth|

[T Disable these settings

+ Current Status ) )
- TCP/IP(Wireless) Specify the TCP/IP(IPv6) settings used with the wireless network.

L. Wireless Settings Static IPv6 Address:

Primary DNS Server IPv6 Address:

Secondary DNS Server IPv6 Address:

oy |

1 Static IPv6 Address
Specifies a permanent IPv6 address.
2 Enable this address
Enables the specified static IPv6 address.
3 Primary DNS Server IPv6 Address/Secondary DNS Server IPv6 Address
Specifies the DNS server IPv6 addresses.
4 IPv6 Address List
Displays the list of IPv6 addresses.

[7]Enable this address 2

| I
w

1Pv6 Address List: 4

61



Change the Printer Settings

Wireless Settings

4 Communication Settings - Wireless LAN > Wireless Settings =
File Tools Help
Printer: Brother R1-4250WB v‘ Wireless LAN Node Namea: JXXXO0CGO000X
Bluetooth Device Name: XX-XXXX XXX
General | Wireless LAN | Wireless Direct | Blustooth
Disable these settings
Current Status
TCP/IP(Wireless) Specify the authentication method used with wireless.
L Ipve . 1
Viireless Settings Infrastructure  EE—
SSID(Network Name):  SETUP W 2
Authentication Method: [Open system v” 4
Encryption Mode: MNone V‘J
Display the key and password on-screen — e — 8
By > Bt

1 Communication Mode
The [Infrastructure] mode setting is available only for RJ-4250WB.
2 SSID (Network Name)
Clicking [Search] displays the available SSID selections in a separate dialog box.
3 Channel
This setting is selected automatically for RJ-4250WB.
4 Authentication Method/Encryption Mode
The supported encryption modes for the authentication methods are as shown in Authentication Methods
and Encryption Modes on page 63.
5 WEP Key
You can specify a setting only when WEP is selected as the encryption mode.
6 Passphrase
You can specify a setting only when WPA/WPA2-PSK is selected as the authentication method.
7 User ID/Password

You can specify settings only when EAP-FAST, PEAP, EAP-TTLS or EAP-TLS is selected as the
authentication method. In addition, with EAP-TLS, it is not necessary to register a password, but a client
certificate must be registered. To register a certificate, connect to the printer from a web browser, and then
specify the certificate. For more information, see Web Based Management on page 139 or Install
Certificates (RJ-4250WB only) on page 54.

8 Display the key and password on-screen

If this check box is selected, keys and passwords are displayed in plain (non-encrypted) text.
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Authentication Methods and Encryption Modes

Authentication Method

Encryption Mode

Open System

None / WEP

Shared Key

WEP

WPA/WPA2-PSK

TKIP+AES / AES

EAP-FAST/NONE

TKIP+AES / AES

EAP-FAST/MS-CHAPv2

TKIP+AES / AES

EAP-FAST/GTC

TKIP+AES / AES

PEAP/MS-CHAPv2

TKIP+AES / AES

PEAP/GTC

TKIP+AES / AES

EAP-TTLS/CHAP

TKIP+AES / AES

EAP-TTLS/MS-CHAP

TKIP+AES / AES

EAP-TTLS/MS-CHAPv2

TKIP+AES / AES

EAP-TTLS/PAP

TKIP+AES / AES

EAP-TLS

TKIP+AES / AES

@ Important
To specify higher level security settings:

When performing certificate verification with EAP-FAST, PEAP, EAP-TTLS or EAP-TLS authentication

methods, the certificate cannot be specified from the Printer Setting Tool. After the printer is configured to

connect to the network, specify the certificate by accessing the printer from a web browser.

For more information, see Web Based Management on page 139 or Install Certificates (RJ-4250WB only)

on page 54.
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Wireless Direct Tab (RJ-4250WB Only)

Wireless Direct Settings

File Tools Help

4 Communication Settings - Wireless Direct > Wireless Direct Settings =]

Printer: |Brother RI-4250WB

v| Wireless LAN Node Name: JOO00000000CKXXX

Bluetooth Device Name: J}X-30OXK_XCO0(

| General | wireless LAN | Wireless Direct | glustooth|

Disable these settings
Current Status .

B \\ireloss Direct Settings Specify the Wireless Direct settings.
SSID/Network Key Generation: |STATIC - '7» 1
SSID(Network Name): DIRECT- X000 XX-X000C
Network Key: JOOOCOK
Channel: A - —_— 3

foply  |v Exit

1 SSID/Network Key Generation
Available settings: [AUTO], [STATIC]

2 SSID (Network Name)/Network Key

Specifies the SSID (25 ASCII characters or fewer) and the network key (63 characters or fewer) you want

to use in the Wireless Direct mode.

You can only specify a setting when [STATIC] is selected for [SSID/Network Key Generation].

Note

The factory default SSID is "DIRECT-*****_RJ-4250WB" and password is "425*****"

***** is the last five digits of the serial number.
(You can find the serial number label on the base of the printer.)

3 Channel

Specifies the channel to use in the Wireless Direct mode.
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Bluetooth Tab

Bluetooth Settings

4 Communication Settings - Bluetooth > Bluetaoth Settings =
File Tools Help

Printer: [Brother R1-4250WB v] Wireless LAN Node Namea: XXXOOCGO000X
Bluetooth Device Name: XX-XXXX_XXXX

General | Wireless LAN | Wireless Direct | Bluetooth |

[ Disable these settings

Current Status

Bluetooth Settings| Select the Bluetooth mode.

++ Classic

Auto re-pairing Bluetooth Mode: Classic & Low Energy o) 1

Low Energy

oy |

1 Bluetooth Mode
Set the control mode when Bluetooth is enabled.
Available settings: [Classic & Low Energy], [Classic Only], [Low Energy Only]
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Bm Classic

4 Communication Settings - Eluetooth > Bluetooth Settings > Classic =
File Tools Help

Printer: ‘Brnther R1-4250WB vJ Wireless LAN Node Namea: JXXXOOCGO000X
Bluetooth Device Name: XX-XXXX_XXXX

General | Wireless LAN | Wireless Direct | Bluetooth |

Disable these settings

Current Status

Bluetooth Settings Specify the Classic Bluetooth settings.
R Classic S
Auto re-pairing Visible to Other Devices: Discoverable vji» 1

Low Energy
Legacy pairing for Bluetooth 2.0 and earlier
| change PIN code 2

Display the PIN code on-screen 3

Pairing for Bluetooth 2.1 and later(SSP)

Request Secure Simple Pziring (S5P) settings during pairing

1 Visible to Other Devices
Allows the printer to be “discovered” by other Bluetooth devices.
Available settings: [Discoverable], [Not Discoverable]
2 Change PIN code
If this check box is selected, you can change the PIN code.
3 Display the PIN code on-screen
If this check box is selected, your computer displays the PIN by default.
4 Request Secure Simple Pairing (SSP) settings during pairing
If this check box is selected when using Classic Bluetooth Mode, it is necessary to perform additional

printer key operations to press 1" (Feed) / OK button in the printer (authentication process) when
pairing with devices running Bluetooth Version 2.1 or later.
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* Auto re-pairing

-4 Communication Settings - Bluetooth > Bluetooth Settings > Classic > Auto re-pairing =
File Tools Help

Printer: ’Bmther R1-4250WB v] Wireless LAN Node Namea: JXOO00CBO0000G0X
Bluetooth Device Name: XX-XXXX_XXXX

General I Wireless LAN | Wireless Directl Bluetooth |

[ Disable these settings

Current Status

Bluetooth Settings Control Auto Re-pairing of Phone/iPad Bluetooth devices.
i Classic
i Low Energy

[ Delete Auto Re-paired Device... }

PR

1 Auto re-pairing

Sets whether or not to automatically reconnect to a previously connected iOS device.
Available settings: [Enable], [Disable]

2 Delete Auto Re-paired Device
Pressing this button deletes information for auto re-paired devices registered in the printer.
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H Low Energy

-4 Communication Settings - Bluetooth > Bluetooth Settings > Low Energy =
File Tools Help

Printer: \BrDther R1-4250WB 'J Wireless LAN Node Name: JXOO00CBO0000G0X
Bluetooth Device Name: XX-XXXX_XXXX

General I Wireless LAN | Wireless Directl Bluetooth |

[T Disable these settings

Current Status

Bluetooth Settings Specify the Bluetooth Low Energy (LE) settings.
i Classic e
- Auto re-pairing Minimum Security Mode: None ,Ii» 1

—2

[C] Request Secure Simple Pairing (S5P) settings during pairing

1 Minimum Security Mode
Select the minimum security level when using [Low Energy Only] mode.
Available settings: [None], [Unauthenticated Encryption], [Authenticated Encryption], [LE Secure
Connections]
2 Request Secure Simple Pairing (SSP) settings during pairing
If this check box is selected when using [Low Energy Only] mode, additional Printer key operations to

press [ (Feed) / OK button in the printer (authentication process) are required when pairing with Low
Energy compatible devices.

68



Change the Printer Settings

Apply Setting Changes to Multiple Printers

0 After applying the settings to the first printer, disconnect the printer from the computer, and then connect
the second printer to the computer.

9 Select the newly connected printer from the [Printer] drop-down list.

Note

If the [Automatically detects the connected printer, and retrieves the current settings] check box in
the [Option Settings] dialog box is selected, the printer connected with the USB cable is automatically
selected.

For more information, see Communication Settings on page 51.

@ ciick [Apply].
The same settings that were applied to the first printer are applied to the second printer.

Note

We recommend selecting the [Automatically restart the printer after applying new settings] check box
when configuring the first printer so that you can confirm that a connection with the Wi-Fi access
point/router can be correctly established with the settings. For more information, see Communication
Settings on page 51.

0 Repeat steps @ — @ for all printers whose settings you want to change.

@ Important
If the first printer's IP address is set to [STATIC], the other printers will also use the same address. If
needed, you can change each printer's IP address in the [Wireless LAN] tab.

Note

To save the current settings in a file, click [File] - [Export].

The same settings can be applied to another printer by clicking [File] - [Import], then selecting the
exported settings file. (See Communication Settings on page 51.)
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Device Settings

With [Device Settings] in the Printer Setting Tool, printer settings can be specified or changed when
connecting the printer and computer with a USB cable or via a Bluetooth connection. Not only can you change
the device settings for one printer, but you can also apply the same settings to multiple printers.

When printing from a computer applications, various print settings can be specified from the printer driver;
however, by using [Device Settings] in the Printer Setting Tool, more advanced settings can be specified.

When [Device Settings] is opened, the printer’s current settings are retrieved and displayed. If the current
settings could not be retrieved, the previous settings are displayed. If the current settings could not be
retrieved and previous settings have not been specified, this tool’s default settings are displayed.

Settings Dialog Box

2 ——Frinter: [Brother R1-42308 | CurentSettngs  ——5§
3 —{ Basc |‘i§ Advanced | ']T&iPnnt Position / Sensor :ib Display Settings “
4 ———{"Disable these settings
Power Settings =
Auto Power On: [on -
Auto Sleep: [3Minutes -
Auto Power Off: [vene =)
Battery Charge Level: [100% i
Printer Settings 6
Command Mode: |P-touch Template -
Text Direction: [Normal -
Print Speed: [5ips { 152.4mmjs -
Print Density: o ¥
align Paper Leading Edge when the Cover is Do not Feed -
ey [ et 7

1 Menu Bar

Select a command contained in each menu from the list.
2 Printer

Specifies the printer whose device settings are to be configured.

If only one printer is connected, it is unnecessary to make a selection because only that printer will appear.
3 Settings Tabs

Contains settings that may be specified or changed.
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Note

If ﬁ’& appears in the tab, the settings in that tab cannot be specified or changed. In addition, the settings

in the tab will not be applied to the printer even if [Apply] is clicked. The settings in the tab will also not be
saved or exported when the [Save in Command File] or [Export] command is executed.

4 Disable these settings

When this check box is selected, ]'_]’b appears in the tab, and the settings can no longer be specified or
changed.

Settings in a tab where ﬁ’& appears will not be applied to the printer even if [Apply] is clicked. In addition,
the settings in the tab will not be saved or exported when the [Save in Command File] or [Export]
command is executed.

5 Current Settings
Retrieves the settings from the currently connected printer and displays them in the dialog box. Settings

will also be retrieved for parameters on tabs with ]T& .

6 Parameters
Displays the current settings.
7 Exit
Exits [Device Settings], and returns to the main window of the Printer Setting Tool.
8 Apply
Applies the settings to the printer.
To save the specified settings in a command file, select [Save in Command File] from the drop-down list.

The saved command file can be used with the mass storage mode to apply the settings to a printer. (See
Mass Storage Mode on page 92.)

71



Change the Printer Settings

Menu Bar

Maintenance About(H)...

1——1—— Apply Settings to the Printer...

2 —t+—— Check Setting...

3— Save Settings in Command File...
4 —1— Import...

5——— Export...

Exit

Maintenance | About(H]...

Save Print Log in File., — 6
Print Unit Settings... 7

Reset to Factory Defaults.., ——1—8

Reset only Device Settings.., ———9
Delete Template and Database.. ———— 10
Delete Print Log... i 11
Option Settings... i 12
File Maintenance About{H]... 13

1 Apply Settings to the Printer

Applies the settings to the printer.

Performs the same operation as when [Apply] is clicked.
2 Check Setting

Displays the setting currently registered.
3 Save Settings in Command File

Saves the specified settings in a command file.

Performs the same operation as when [Save in Command File] is selected from the [Apply] drop-down

list.
4 Import
Imports the exported file.
5 Export
Saves the current settings in a file.
6 Save Print Log in File
Saves the print log in a file in the CSV format.
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7 Print Unit Settings
Prints a report containing firmware version and device setting information.
You can also print this report using the 1[3 (Feed) / OK button (see Print the Printer Information
on page 91).
8 Reset to Factory Defaults
Resets all printer settings to factory settings.
9 Reset only Device settings

Resets the settings that can be changed in the Device Settings to factory settings. The templates,
databases and print log stored in the printer are not reset.

10 Delete Template and Database

Deletes the templates and databases stored in the printer.
11 Delete Print Log

Deletes the print log stored in the printer.
12 Option Settings

If the [Do not display an error message if the current settings cannot be retrieved at startup] check
box is selected, a message will not be displayed next time.

13 About
Displays the version information.
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Basic Tab
% Device Settings (==
File Maintenance About(H)...
== [Brother R1-42308 - [ CumentSetings |
Basic | Advanced | Print Position / Sensors | Display Settings|
[T Disable these settings
Power Settings
1 Auto Power On: [on -
2 Auto Sleep: IaM\nutes 'I
3 Auto Power OFF: [off -
4 Battery Charge Level: [100% -
Print Settings
5 ommand Mode: [P-touch Tempiate -
6 Text Direction: INormaI 'I
7 Print Speed: IE ips [ 127 mm/s 'I
8 Print Density: [o -
9 é:gvez?per Leading Edge when the Cover is IDo not Feed 'I
[ Ry J [ Exit

1 Auto Power On

Specifies whether the printer turns on automatically when the AC Power Cord is plugged into an electrical
socket.

Available settings: [On], [Off]
2 Auto Sleep
Designates the amount of time to elapse before the Printer automatically goes into sleep mode.
Available settings: [Off], 1/2/3/4/5/6/7/8/9 minutes
3 Auto Power Off
Specify the amount of time that passes before the printer turns off automatically.
Available settings: [Off], 10/30 minutes, 1/3/6/9/12 hours
4 Battery Charge Level
Specify the maximum charge level.
Available settings: [80 %], [100 %]

Note

To get the longest life from the battery, select [80 %)]. Although the number of pages that can be printed
on a single charge will be less when you select [80 %], you can get a longer overall battery life.

5 Command Mode
Select the printer's command format.

Available settings: [Raster], [ESC/P], [P-touch Template], [CPCL emulation], [CPCL Line Print
emulation]
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6 Text Direction
Select the printing orientation.
Available settings: [Normal], [Inverted 180 Degrees]
This setting is applied only if the printer driver is not used. If the printer driver is used, the setting specified
in the driver will be applied.
7 Print Speed
Select the printer’s printing speed.
Available settings: [3 ips / 76.2 mm/s], [4 ips / 101.6 mm/s], [5 ips / 127 mm/s]
8 Print Density
Adjust the printer’s printing density.
Available settings: -5—+5
9 Align Paper Leading Edge when the Cover is Closed
Select whether the paper is automatically fed when the cover is closed.
Available settings: [Feed], [Do not Feed]
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Advanced Tab

'} Device Settings
File Maintenance About(H)...
Printer: Brother R1-42308 - Current Settings |
Basic | Advance d | Print Position / Sensor | Display Settings
" | Disable these settings
Key Function
1 Feed Key Function: [Feed -
2 Menu Key Function: [Menu -
Print Information Report
3 Contents: [a -
Others
4 IPEG Printing Setting: [Error Diffusion -
5 Serialize Mode: [cont From Last -
6 Save Printer Print Log: [Enable -
7 Print Data after Printing: [Erase Al print Data )
8 Airplane Made: ‘Oﬂ‘ = ‘
Q ———— Linerless: ot -
‘ Apply ‘ ‘ Exit ‘

1 Feed Key Function
Select the operation that is performed when the t[3 (Feed) / OK button is pressed.
If [Program Settings] is selected, click the [File] button and select the command file.
Available settings: [Feed], [Disable], [Program Settings]

2 Menu Key Function
Select the operation that is performed when the Menu / ¥ (Select) button is pressed.
If [Program Settings] is selected, click the [File] button and select the command file.
Available settings: [Menu], [Disable], [Program Settings]

3 Printer Information Report
Select which sections are printed when printing the printer setup information.
Available settings: [All], [Usage Log], [Printer Settings], [Printer Transfer Data]
(See Print the Printer Information on page 91)

4 JPEG Printing Setting
Selects the method of image processing when printing JPEG images.
Available settings: [Simple Binary], [Error Diffusion]

5 Serialize Mode
Select whether or not to serialise from the last number printed.
Available settings: [Cont From Last], [From Starting#]

6 Save Printer Print Log

Select whether or not to save the printer’s print log. If [Disable] is selected, [Maintenance] - [Save Print
Log in File] cannot be enabled.

Available settings: [Enable], [Disable]
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7 Print Data after Printing
Select whether or not print data is erased automatically after it is printed.
Available settings: [Erase All Print Data], [Keep Print Data]

8 Airplane Mode

Disables the Bluetooth interface and Wi-Fi connection. This function is useful when you use the printer in
a place where signal transmissions are not allowed.

Available settings: [On], [Off]

9 Linerless
Select when using linerless media.
Available settings: [On], [Off]
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Print Position / Sensor

If RD Rolls are being used, you do not need to adjust the sensors.

Y Device Settings
File Maintenance About(H)...
Printer: Brother R1-42308 - Current Settings |
[ Basic [ Advanced | Print Position / Sensor | Display Settings |
| Disable these settings
Adjustment
1 — Printing Reference Paint Adjustment: Along Label Width: 000 = -
*Does not adjust raster prints along Label Length: 0oo 2y ot
2 — Tear Adiust: oo0 =] -
3 — 1 Media Sensor {Transmissive, JGap)
Detection Sensitivity: o -
Luminescence Adjustment: o -
4} ———Media Sensor (Reflective Bar)
Mark Detection Sensitivity: ‘EI -
Luminescence Adjustment: o -
[ ey -] Exit |

1 Printing Reference Point Adjustment Along Label Width / Printing Reference Point Adjustment
Along Label Length

Adjust the position of the reference point (point of origin for printing). This corrects printing misalignments
resulting from differences in printer models or from the fixed margins of some software.

The reference point cannot be adjusted for raster printing.
Available settings: [Along Label Width]: -150.0 mm to 150.0 mm, [Along Label Length]: -10.0 mm to
10.0 mm
2 Tear Adjust
Adjust the tear bar tear off position for paper media.
Available settings: -10.0 mm to 10.0 mm
3 Media Sensor (Transmissive/Gap)
The following transmissive/gap sensor parameters can be adjusted.
[Detection Sensitivity]
Adjust the precision of the sensor that detects the gaps (spacing) for die-cut labels.
Available settings: -2—+2
[Luminescence Adjustment]
Adjust the amount of light emitted by the transmissive/gap sensor.
Available settings: -2—+2
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4 Media Sensor (Reflective/Bar)
The following reflective/black mark sensor parameters can be adjusted.
[Mark Detection Sensitivity]
Adjust the precision of the sensor that detects the black marks.
Available settings: -2—+2
[Luminescence Adjustment]
Adjust the amount of light emitted by the reflective/black mark sensor.
Available settings: -2—+2
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Display Settings Tab
'} Device Settings
File Maintenance About(H)...
Printer: Brother R1-42308 - Current Settings |
| Basic | Advanced | print Position [ Sensor | IDEDBV SEYU;VDS ] L
| Disable these settings
Display Settings
1 —_— Language: ‘Enghsh vJ
2 ———— LoD Contrast: o -
3 ———— Badklight Timeout: [10s -
Tone Settings
4 ———— Beeper: [on -
[ ey -] Exit
1 Language

Select the language for the LCD.

Available settings: [Dansk], [Deutsch], [English], [Espafiol], [Francais], [Italiano], [Nederlands],
[Norsk], [Portugués], [Suomi], [Svenska], [+xX], [H &:E]

Note

The available display languages may differ depending on the printer model being used. If the selected
language cannot be used for the LCD, the display language will not be changed.
Make sure that the LCD can display the selected language.

2 LCD Contrast
Select the brightness of the LCD.
Available settings: -2—+2
3 Backlight Timeout
Specify the amount of time of inactivity before the backlight of the LCD turns off automatically.
Available settings: [Off], [5s], [10s], [20s], [30s], [60s]
4 Beeper
Select whether the printer beeps when it is turned on or off, or if an error occurs.
Available settings: [On], [Off]
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Apply Setting Changes to Multiple Printers

0 After applying the settings to the first printer, disconnect the printer from the computer, and then connect
the second printer to the computer.

9 Select the newly connected printer from the [Printer] drop-down list.

@ ciick [Apply].
The same settings that were applied to the first printer are applied to the second printer.

0 Repeat steps @ — @ for all printers whose settings you want to change.

Note

To save the current settings in a file, click [File] - [Export].

The same settings can be applied to another printer by clicking [File] - [Import], and then selecting the
exported settings file. (See Device Settings on page 70.)
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P-touch Template Settings

P-touch Template mode provides functions for inserting data from an external device (such as a barcode
reader, controller or programmable logic device connected to the printer) into text and barcode objects in
layouts saved on the printer, useful for printing templates and barcodes.

With [P-touch Template Settings] in the Printer Setting Tool, settings for using the P-touch Template
functions can be specified or changed.

To use the P-touch Template functions, you must send the template to the printer using the transfer function.
For more information about the transfer function, see How to Use P-touch Transfer Manager & P-touch
Library on page 105.

P-touch Template

The following are the P-touch Template functions:

Basic operations
B Preset template printing

If frequently used templates are stored in the printer, they can be reprinted by simply scanning the barcode
for each template.

B Barcode printing

A barcode scanned with the barcode reader can be printed with the protocol and size of a previously
created template.

B Database-assisted template printing

By linking objects in a template to a database, then scanning the key barcodes for the database, the
template can be printed with objects in the template replaced with database data.

Advanced operations
B Numbering function (serialised number) printing
Templates can be printed while automatically incrementing a number or barcode in the templates.

Note

If a command reference is used, see the P-touch Template Manual/Command Reference. You can
download the latest versions from the Brother support website:

1 Go to support.brother.com

2 Select your model, and then select [Manuals].
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P-touch Template Settings Dialog Box

1 P-touch Template Settings - Brother RI-42308 ===
Set the Default Command Mode to [P-touch Template].
Spedify the settings necessary for the transferred template.
If a different Defauit Command Mode is selected, use [Device Settings].
To indicate a control code in the text box, put "\mark before ASCII code [00 FF].
ex. TAB: 09, CR: \0D, \: 1\ as lbyte each
2 —|— Default Template Number: [1] =
3 —— Data Delimiter for P-touch Template: 09
4 —— Trigger for P-touch Template Printing
@ Command Character: ~FF
Data Insertion into All the Objects
Received Data Size:
B —— Character Code Table: Windows 1252 -
@ —t— International Character Set: United States -
[ —T— Command Prefix Character: ~
8 —— Mon-Printed Character:
9 —— Available Return Code: ACR -
10— [IrepizceFrct
Default Print Option
11 —1— Number of Copies: 1
12— [inverted 180 Degrees
Default 15
set - Cancel
| I

Default Command Mode

Specifies the P-touch Template mode as the default mode.

To change the mode, use the Device Settings.

Default Template Number

Specifies a template number to select as default when the printer is turned on.

However, if a template is not to be transferred to the printer, do not specify a template number.

Data Delimiter for P-touch Template

A symbol used to indicate the boundaries between groups of data in a file. Between 1 and 20 characters
can be specified.

Trigger for P-touch Template Printing

You can specify a trigger to begin printing from a number of options.

[Command Character]: Printing starts when the command character specified here is received.

[Data Insertion into All the Objects]: Printing starts when the delimiter for the last object is received.
[Received Data Size]: Printing starts when the number of characters specified here is received. However,
delimiters are not counted in the number of characters.

Character Code Table

Select one of the following character code sets:

Available settings: [Windows 1251], [Windows 1252], [Windows 1250 Eastern Europe], [Brother
standard], [Unicode]
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6 International Character Set
Lists character sets for specific countries or regions.

Available settings: [United States], [France], [Germany], [Britain], [Denmark], [Sweden], [Italy],
[Spain], [Japan], [Norway], [Denmark II], [Spain Il], [Latin America], [Korea], [Legal]

The following 12 codes are switched depending on the country or region selected from the list above:
23h 24h 40h 5Bh 5Ch 5Dh 5Eh 60h 7Bh 7Ch 7Dh 7Eh
For switched characters, see the P-touch Template Manual/Command Reference (which can be
downloaded from the Brother support website).

7 Command Prefix Character
Specifies the prefix character code, which identifies commands used in P-touch Template mode.

8 Non-Printed Character
Characters specified here are not printed when data is received. Specify 1 to 20 characters.

9 Available Return Code

The line feed code is used when feeding data to indicate that the following data should be moved to the
next line in a text object. One of the following four line feed codes can be selected, or 1 to 20 characters
can be specified as the line feed code.

Available settings: [*CR], [\OD\0A], [\0A], [\0OD]
10 Replace FNC1
See the P-touch Template Manual/Command Reference.
11 Number of Copies
Set the number of copies. A number between 1 and 99 can be specified.
12 Inverted 180 Degrees
If this check box is selected, the data will be printed after it has been rotated 180 degrees.
13 Set
After the [Set] button is clicked, the settings are saved as an .ini file when the dialog box is closed.

To save the specified settings in a command file, select [Save in Command File] from the drop-down
menu. The saved command file can be used with the mass storage feature to apply the settings to a
printer. (See Mass Storage Mode on page 92.)

14 Cancel
Cancels the settings and closes the dialog box. The settings will remain unchanged.

15 Default
Click this button to return the settings to their factory defaults.
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Paper Size Setup
With [Paper Size Setup] in the Printer Setting Tool, paper sizes not available in the [Paper Size] list of the
printer driver can be added.

Before you print using a paper size other than the available ones, you must register the new paper size by
sending it to the printer.

Printing with a paper size not registered with the printer may produce incorrect print results.

Paper Size Setup Dialog Box

.48, Paper Size Setup @
Currently Registered Paper Sizes:
Width: 58.0 mm
RD 102mm
RD 50mm x 5mm Length: —mm [ 1
RD &0mm x 92Zmm
RD 80mm x 115mm Energy Rank: 4
RD 102mm x 26mm
RD 102mm x 50mm
RD 102mm x 76mm
RD 102mm x 102mm
RD 102mm x 152mm
New... 2
| Ee. 13
Paper list
Import... :'— 5
Export... :'— 6

| |
8 7

1 Current settings
Displays the current settings for the selected paper format.
2 New

Click this button to display the [New] dialog box and register a new paper size. For details, see New Dialog
Box on page 87.

@ Important
Do not register a paper size that has already been registered, to avoid incorrect print results.

To use paper of the same size as one that is currently registered, select the size you want from the

[Currently Registered Paper Sizes] list in the [Paper Size Setup] dialog box, and then change and
overwrite the settings from the [Edit] dialog box.

3 Edit
Edits the settings for the selected paper format.

To save the selected paper format with the new settings, click [Overwrite]. To add a paper format with the
new settings, change the name in the [Paper Size Name] box, and then click [Add].

4 Delete
Deletes the selected paper format. A deleted paper format cannot be restored.
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5 Import

Reads the text file containing the paper format settings and uses it to replace the contents of the
[Currently Registered Paper Sizes] list.

@ Important
When the list is imported, the entire contents of the [Currently Registered Paper Sizes] list will be
replaced with the imported paper formats.

6 Export
Exports the paper formats in the [Currently Registered Paper Sizes] list to a file. The exported formats
can then be distributed to other computers. For details, see Distribute Paper Formats on page 90.
7 Exit
Exits [Paper Size Setup], and returns to the main window of the Printer Setting Tool.
8 Option
Click the ¥ button, and then select an operation.

Click [Register Paper Size With Printer] to register the settings for the selected paper format in the
printer.

Click [Save in Command File] to export the paper settings as a command file. (The file extension is “.bin”.)

Note

When the paper format is registered with the printer and [Exit] is clicked, the [Paper Size Setup] dialog
box appears with the added paper size in the [Currently Registered Paper Sizes] list. If the software is
running, exit the software, and then restart it for the new paper format to appear in the list.

« If the following functions are being used, you can quickly apply their settings to the printer.
* Mass storage feature (page 92)
 Bluetooth (Object Push Profile (OPP))
» Wi-Fi (File Transfer Protocol (FTP))

@ Important
These settings commands are only intended to be used for applying settings to a printer. These
commands cannot be imported into [Paper Size Setup].
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New Dialog Box

New &=
4 ——t—Pape Size Name:
[New Paped
D ——{—Papsi Types:
| Continuous Length Tape -
58,0 mm
Width: [120-1140] 580 5] mm
‘ Length [6.0-10000] 00 mm
Label Spacing 0o o
Widhh of Marks 0o o
Distaree Pk PapeiLeadna BBt Maks (a0 o — 3
Left Margin 15 i
+30mn
% Fiight Margin: 15 mm
C 430mn Top Margin: 30 m
R
15mm - 1.5mm Bottom Margin a0 mm
Advanced Prinling Adjustments. +H—4
[ Add Concel |

1 Paper Size Name

Type in the name of the paper format to be added.
2 Paper Types

Select the paper type.

Available settings: [Continuous Length Tape], [Die-cut Label], [Media With Marks]

3 Detailed settings
Specify details for the paper format to be added.

4 Advanced Printing Adjustments

Click this button to display the [Advanced Printing Adjustments] dialog box and make advanced printing

adjustments for each paper format. For details, see Advanced Printing Adjustments Dialog Box

on page 88.
5 Cancel

Cancels the settings and closes the dialog box. The settings will remain unchanged.

6 Add
Click this button to add the paper format.
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Advanced Printing Adjustments Dialog Box

Advanced Printing Adjustments @

1 ——— Piinting Reference Point Adjustment

Specify adjustments to the reference point (point of ongin for printing). Printing misalignments
resulting fram differences in printer models or the fixed marging of some applications can be
comected.

I | &long Label Wik W = o
LaBC [-150.0- 1500 ]

[t DEF

00 mm ! i Along Label Length: 0.0 = mm
¥ [-150.0-150.0]
0.0 mm . =

2 Tear Adjust; 0.0 < mm
3 ——— Energy Rark

Change the setting when the heat guantity from the print head changes. for example, vwhen
the print density is adjusted, such as with special paper. Mormally, it iz not necessam to
change the setting.

Energy Rank: 4 -
4 ——— Media Sensar [Transmissive/Gap)

Detection Sensitivity: 1]

Luminescence Adiustment i
5 —— Media Sensar [Reflectives/Bar)

Mark. Detection S ensitivity: 1]

Luminescence Adjustment: 1]

[ 0K ] ‘ Cancel |
| |

1 Printing Reference Point Adjustment
Adjust the position of the reference point (point of origin for printing). This corrects printing misalignments
resulting from differences in printer models or from the fixed margins of some software.
2 Tear Adjust
Adjust the cutting position when the paper is cut using the tear bar.
Available settings: -10.0 mm to 10.0 mm
3 Energy Rank

Select a setting when it is necessary to adjust the amount of heat (energy) from the print head, for
example, with special paper.

Note

There may be contrast variations in the print result due to the operating environment and media used.
Change the setting if necessary.

4 Media Sensor (Transmissive/Gap)

Adjust the precision with which the transmissive/gap sensor detects the gaps (spacing) for die-cut labels
and the amount of light emitted by the sensor.

Settings can be specified when [Paper Types] is set to [Die-cut Label].
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Note

Because the settings for [Media Sensor (Transmissive/Gap)] in the [Device Settings] dialog box (See
Print Position / Sensor on page 78) will have an effect, specify appropriate values.

Example settings:

Setting EX1 Setting EX2
Device Settings +2 -2
Paper Size Setup +2 +2
Actual effect 4 0

5 Media Sensor (Reflective/Bar)

Adjust the precision with which the reflective/black mark sensor detects black marks and the amount of
light emitted by the sensor.

Settings can be specified when [Paper Types] is set to [Media With Marks].

Note

Because the settings for [Media Sensor (Reflective/Bar)] in the [Device Settings] dialog box (See Print
Position / Sensor on page 78) will have an effect, specify appropriate values.

Example settings:

Setting EX1 Setting EX2
Device Settings +2 -2
Paper Size Setup +2 +2
Actual effect 4 0
6 OK

Saves the settings and returns to the previous dialog box.

7 Cancel
Cancels the settings and closes the dialog box. The settings will remain unchanged.
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Distribute Paper Formats

The paper formats exported from the [Currently Registered Paper Sizes] list can be distributed to other
computers.

Distributing Only Paper Formats

If the printer driver has been installed on the recipient’s computer, only the paper formats need to be
distributed.

0 At the sender’s computer, specify the paper format settings, and then click [Export]. (For details, see
Paper Size Setup on page 85.)
The following files are created: bsr425ed.txt, bsr425ed.ptd, pdt4437.bin or bsr423ed.txt, bsr423ed.ptd,
pdt4337.bin

9 Save bsr425ed.txt or bsr423ed.txt in any location on the recipient’s computer.

0 At the recipient’s computer, click [Import].
The paper formats are replaced with the imported ones.

Change Settings When Printing from a Mobile Device

If using a mobile device, change the settings as necessary using the software before printing. The settings
that can be changed vary according to the software.

Note

Before connecting a mobile device, you can specify detailed settings by connecting the printer to a
computer, and using the Printer Setting Tool (see Change the Printer Settings on page 48).
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Print the Printer Information

You can use the [ (Feed) / OK button to print a report that lists the following printer information:
B Program version

B Printer usage history

B Missing dot test pattern

B Printer settings information

W List of transferred data

B Network setting information

Note

* You can use the Device Settings to set in advance which items will be printed (see Device Settings
on page 70).

* The node name appears in the Printer Settings. The default node name is “BRWxxxxxxxxxxxx”. (Where
“Xxxxxxxxxxxx” is based on the printer's MAC Address/Ethernet Address.)

» This operation can also be performed using the Printer Setting Tool.

0 Make sure that a roll of receipt paper has been loaded and the roll compartment cover is closed.

9 Turn the printer on.

0 Press and hold the t[" (Feed) / OK button until [Print ing] appears on the LCD. The printer information
will be printed.

Note

To print a printer information, use 102 mm continuous roll.
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Mass Storage Mode

Description

The mass storage mode feature allows you to send a file via the USB interface without loading a printer driver.
This feature is useful for:

B Applying printer settings saved in a command file (.bin file format) or adding templates (.blf file format)
distributed by the administrator, to the printer.

B Executing commands without installing the printer driver.

B Using a device with an operating system (including non-Windows operating systems) that has a USB host
feature to print and transmit data.

Use of Mass Storage Mode

0 Confirm that the printer is turned off.

9 While pressing the Menu / ¥ (Select) button, press and hold the d) (Power) button.
The printer starts up in mass storage mode. The message [Mass Storage] appears on the LCD.

0 Connect the Windows computer or mobile device to the printer via USB.
The printer's mass storage area is displayed on the computer or device’s screen.

Note

If the mass storage area is not displayed automatically, see the operating instructions for the computer or
device’s operating system for information about displaying the mass storage area.

Drag and drop the file you want to copy to the mass storage area.

Press the Menu / ¥ (Select) button.
The command file is executed. The message [Receiving] appears on the LCD.

After the file has been executed, the message [Mass Storage] appears on the LCD.

Q® 660

To turn mass storage mode off, turn the printer off.
The printer will start up in its normal operating mode.
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@ Important
* When the printer is turned off, mass storage mode is deactivated and any files in the mass storage area
are deleted.

This feature supports “.bin”, “.blf”’, and “.jpg” files. Do not use other file formats with this feature.
» Do not create folders in the mass storage area. If a folder is created, files in the folder will not be executed.
» The capacity of the mass storage area is 15.8 MB.

If multiple files are copied, the order that the files will be executed in cannot be guaranteed.

Wi-Fi and Bluetooth are not available while the printer is running in mass storage mode.
» Do not access other files in the mass storage area when executing a copied file.

Print JPEG Images

Image data (JPEG) can be printed without using the printer driver.

Note

+ JPEG images can be printed using the mass storage feature.
The Object Push Profile (OPP) is used for printing via a Bluetooth connection.

This printer will convert a colour JPEG image to a ‘Black & White’, image using a dithering process.

* When sending a JPEG image that is already ‘Black & White’ this dithering process may make your printed
image fuzzy.

» To improve the image quality, try to turn off any preprocessing of the JPEG image.

B Only JPEG images can be printed. (Limited to files with the .jpg extension.)
B The maximum file size is 15.8 MB.
B The maximum resolution is as follows:
Height x Width = 24000 x 832 dots
If these limits are exceeded, the data received by the printer will be discarded and not printed.
B 1 printed pixel = 1 dot.
B This printer performs binary processing (simple binary) to print the image.
B The image is printed with the height-to-width proportion of the received data.

Remote Update (RJ-4250WB Only)

The Remote Update feature allows for the semi-automatic update of the printer's settings with a simple
connection to a network folder where the update files reside. For more information about Remote Update,
see Remote Update (RJ-4250WB only) on page 45.
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How to Use P-touch Editor

Use of P-touch Editor

You must install P-touch Editor and the printer driver to use the printer with Windows computer.

To download the latest driver and software, visit our website at:
install.brother

Start P-touch Editor

0 For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [P-touch Editor 5.2] under [Brother P-touch], or double-click the [P-touch Editor 5.2]
icon on the desktop.

For Windows 8/ Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2
(RJ-4250WB)

Click [P-touch Editor 5.2] on the [Apps] screen or double-click the [P-touch Editor 5.2] icon on the
desktop.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Editor 5.2], or double-click the [P-touch
Editor 5.2] shortcut icon on the desktop.

9 When P-touch Editor starts, select whether you want to create a new layout or open an existing layout.

Note

To change how P-touch Editor starts, click [Tools] > [Options] in the P-touch Editor menu bar to display
the [Options] dialog box. On the left side, select the [General] heading and then the setting you want in
the [Operations] list box under [Startup Settings]. The factory setting is [Display New View].
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How to Use P-touch Editor

@ Select an option in the screen.

1@ P-touch Editor - [Layoutl] |E=EESE P

Printer: Brother R1-42308 -

To create a new layout, double-click [New Layout], or click [New Layout] and then click [—].

2 To create a new layout using a preset layout, double-click a category button, or select a category
button and then click [ ].

3 To connect a pre-set layout to a database, select the check box next to [Connect Database].
4 To open an existing layout, click [Open].
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Print with P-touch Editor

B Express mode
This mode allows you to quickly create layouts that include text and images.

@ P-touch Editor - [Layout2 ol
File Edit View Insert Format Tools Layout Window Help BEE
— mas =] h
LM A @ Y e -
New/Open | Paper Text Frame  Image  Favorites | layout Print Save Express
®AFN-O-BA|2 X hBeYB0
Allows the paper length, vidth and = O P O
orientation to be specified.
RD 10 |
17 Media size =
Media: E L 2]
E71 [Ro 1020m M= |
Length: E & [
= o == [
[ Autolength E 1
= 1
Margns: = /,.
:I” &mm % s = L]
I Orientation =
F‘ ©) Herizontal =
© Vertical =
W Pumose E
E
B a o« n B
¢ Snap Express Professional Erother RJ-42308 - O [mz -] @

Configure the settings in the Print screen before printing.
To print, click [File] > [Print] from the menu bar or click the print icon.
B Professional mode
This mode allows you to create layouts using a wide-range of advanced tools and options.

@ ==
File Edit View Inset Format Tools Layout Window Help [—]=]x]
S [Normal Format = Arial MEZR B+ 2T 4 b[E
aw R sm [ B I U & [ A & Z% EHE =
7[R0 102 <) =Tl ICEELEET EI L]
M Insert New »
A = Pl P Pt o Pt el T e e g
=1p) ) Text Arrange Text
= [~ ]
.
= Bar Code Decorative
E il
= Z a r
E ’
= Table Image
=
3 . T
E . “ L
= Screen Cip Art
= Capture
E
= - Symbol  MakePicture

sy I Fofessionsi

Configure the settings in the Print screen before printing.
To print, click [File] > [Print] from the menu bar or click the print icon (A).
In addition, click the [Print] icon (B) to start printing without changing the settings.
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B Snap mode

This mode allows you to capture all or a portion of your computer screen display, print it as an image, and

save it for future use.

0 Click the [Snap] mode selection button.
The [Description of Snap mode] dialog box appears.

@ cClick [OK].

Description of Snap mode

The following functions can be used in Snap mode.

Streen Capture Drag-and-Drop

P-touch Electronic
Eﬂower ol

Print Text function

=

B
_K@

A.2003|

I Do Mot Display This Dislog Again

Conce

The [Snap] mode palette appears.

?-‘ Snap -

P>
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Tips for Creating Templates

From the computer, use P-touch Editor 5.2, which can be downloaded from the website at install.brother, to
create a label layout. For more information about its use, see How to Use P-touch Editor on page 95.

Create a Template

B Label sample

Strawberry

$ 2.85

0 For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [P-touch Editor 5.2] under [Brother P-touch], or double-click the [P-touch Editor 5.2]
icon on the desktop.

For Windows 8/ Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2
(RJ-4250WB)

Click [P-touch Editor 5.2] on the [Apps] screen or double-click the [P-touch Editor 5.2] icon on the
desktop.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Editor 5.2], or double-click the [P-touch
Editor 5.2] shortcut icon on the desktop.

9 When P-touch Editor starts, select whether you want to create a new layout or open an existing layout.
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9 Click [Paper] (1), and then specify the media and length (2). (This example shows the [Express] mode.)

i
Paper

|N=Imnen

File Edit View Insert Format Tools Layout W

A O¢

Paper
Allows the paper length, width and
orientation to be specified.

} %Al

] Media size
Media:

T [RD].(.IZM

2
1l

[T

=
1

Length:

=
Auto length
Margins:

:|“ &mm

[ Orientation

W (™) Horizontal

@) Vertical

¥ Purpose

[Normal Format

wiluft

@ Click [Text] (1), and then specify the font and style (2).

Text
Allows the text properties to be
specified.

I Fort

mﬂﬂ |‘—+

l I@é Fixed Frame Size

[ Direction

= (@) Horizontal Text
" () Vertical Text
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@ Clicking | A |~ displays the cursor so text can be entered.

&) P-touch Editor - [Layout2]
|@| File Edit View Insert Format Tools Layout Wi

T A 2
%A~

Allows the text properties to be 0|| 1l
specified.

@ After adding the text, click the text box to move it within the template.

»

o Repeat steps @ and @ to enter text and arrange the layout.

@ [File] > [Save as] on the menu bar, and then specify a file name to save the template.
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Insert the Date and Time in a Label

0 In P-touch Editor 5.2, open the label layout you want to edit.

@ On the menu bar, click [Insert] > [Date/Time] to display the [Date and Time Properties] dialog box.
Select settings for the format of the text you want to insert.

Date and Time Properties @
Setup |Text |Font | Drawing

Category Date &Time
@ Date ©) Time [T] At Printing
Format:
Same as 05 (Short date) -
Sample

21 : 1

Add/Subtract

Days

12/13/2020
oK ] [ Cancel

@ Important

The date and time inserted into the label will be printed using the printer's default character size. Because
the character size is determined by the size of the date and time object, adjust the object to the size you

want in P-touch Editor 5.2 before transferring the label layout to the printer.

© 12/13/2020

1N

— A .

N
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Link a Database to a Template

B Label sample

Strawberry Orange Apple

$285| %5155 $ 215

A database can be linked to the template you created. Since the text in the template can be replaced with text
from the database, multiple labels can be printed simply by creating a single template.

For more information on how to create databases and database settings, see [P-touch Editor Help].

0 Prepare a database file in advance.

Note

» Files saved as XLS, XLSX, MDB, CSV, TXT and ACCDB formats can be used as databases.

* Only one database can be linked to a single template. A maximum of 65,000 records can be created in
that database. (The total size of templates and databases combined is limited to 12 MB.)

9 In P-touch Editor 5.2, open the template to be linked to the database.

0 On the menu bar, click [File] - [Database] - [Connect] or | | to display the [Open Database] dialog box.
Select [Connect Database File], click [Browse], and then select the database you want to link.

Open Database @

M Select Database
Select the database to be connected:

@ Connect Database File:

File Name: [E¥  Browse...

Caonnect to MSDE/SQL Server

(an SQL server dlient license is required to connect to an SQL Server database.)

Select the editing mode for the database to be connected.

Cancel

Click [Next].
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@ With [Database Field] under [Merge Fields], specify which database column will be linked to which
object, and then click [OK].

M Mapping Merged Fields. ABC]

A label contains layout objects(textfmages). To pint lbeks rom  catabase, Ik each object toa datzbase H |
field. In the merge fields table, dick the layout object name. In the databas field column choose the fiekd to
be Iinked. Press OK to finish.

Preview: Merge Fields:
Layout Object | Database Field

“Strawberry”
"2.85"

Stranberry

<gack ok | [ cancel

@ The template and database will be linked, and the main window appears. Click to select the database
row with the text to be replaced, and display a preview of the label.

T R P AT e o T e e
ol e Dl obl oo Gl Bl o

$1.55

Orange

Finally, transfer the created template to the printer using P-touch Transfer Manager.
For details, see How to Use P-touch Transfer Manager & P-touch Library on page 105.
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P-touch Library

P-touch Transfer Manager

This program allows you to transfer templates and other data to the printer and save backups of your data on
Windows computer.

First P-touch Transfer Manager transfers data to the printer, and then P-touch Template sends text data that
will be inserted into the template and printed. For more information on P-touch Template, download the
P-touch Template Manual/Command Reference (English only) from the Brother support website at
support.brother.com/manuals.

The transfer function is needed to use P-touch Template.
The template can also be transferred via network.
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Transfer the Template to P-Touch Transfer Manager

To use P-touch Transfer Manager, you must first transfer templates created in P-touch Editor to P-touch
Transfer Manager.

0 In P-touch Editor, open the template you want.

9 Click [File] > [Transfer Template] > [Transfer].
When P-touch Transfer Manager starts, the main window appears.

Note

The following method can also be used to start the P-touch Transfer Manager.
For Windows 10 / Windows Server 2016 (RJ-4250WB):
Click [Start] > [P-touch Transfer Manager 2.3] under [Brother P-touch].

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2
(RJ-4250WB):
Click [P-touch Transfer Manager 2.3] on the [Apps] screen.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB):

Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Tools] > [P-touch Transfer Manager 2.3].
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Main window

All Contents - P-touch Transfer Manager
File Edit View Tool Help

i

= s = 0 = . Printer;
2 —< 2 = \j N Ed Al Printers
; aci e ch

("] P-touch Library | Name | Size| Date | Location

{3 All Contents
B Filter
{8 Recycle Bin
L@ Se sults

[} Transfer Manager

B8 PC (Brother XX-XXXX)
i % Configurations
&) Backups

L) Brother XX-XXXX

No contents are selected.

For Help, press F1

1 Menu bar

Provides access to various commands, which are grouped under each menu title ([File], [Edit], [View],

[Tool], and [Help]) according to their functions.

2 Toolbar
Provides access to frequently used commands.

3 Printer selector

Allows you to select which printer the data will be transferred to. When you select a printer, only the data

that can be sent to the selected printer is displayed in the data list.

4 Folder list

Displays a list of folders and printers. When you select a folder, the templates in the selected folder are

displayed in the template list.

If you select a printer, the current templates and other data stored in the printer are displayed.

5 Template list
Displays a list of templates in the selected folder.
6 Preview
Displays a preview of the templates in the templates list.
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Explanations of the Toolbar Icons

Icon Button name Function
Transfer Trgnsfers templates and other data from the computer to the
printer.
Save Transfer File Changes the file type of the data to be transferred to other software.
@ (When not connected to a Select "BLF" for the filename extension when transferring the data

printer)

using Wi-Fi. Select "PDZ" when transferring the data using
P-touch Transfer Express (USB).

The available interfaces differ depending on your model.

Retrieves the templates and other data saved in the printer and

=1
QU Backup saves it to a computer.
|IT~£"—3’ Open Opens the selected template.
! J
~~ Allows you to search for templates or other data that are registered
- Search .
N to P-touch Library.
g=t: Display Style Changes the file display style.
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Transfer Templates or Other Data from Computer to the
Printer

Use the following procedure to transfer templates, databases and images from the computer to the printer.

0 Connect the computer and the printer via USB, and then turn the printer on.
The printer model name appears next to a printer icon in the folder view.
If you select the printer in the folder view, the current templates and other data stored in the printer
appear.

Note

« If a printer is disconnected or offline, it is not listed in the folder view.

» Before transferring data, check that the computer and the printer are correctly connected via a USB cable
or Wi-Fi, and that the printer is on.

9 Select the printer that you want to transfer the template or other data to.

& Al Contents - P-touch Transfer Manager ool

Eile Edit View Tool Help

@ name KB 11/10/2011 52510... CAUsers\ Lir.

ao KB 111072001 c . Libr
@) address B 111072001 c Libr

For Help, press FL NUM

& PC (Brother XX-XXXX \Configurations - P-touch Transfer Manager = =]
File Edit View Tool Help
=] = =g @ .- Printer:
Lo =0 = ho J All Printers -
sfer & : Search Display Style
=] P-touch Library Transfer Name | Size | Type | Date | Key Assign Name
(23 All Contents @ name KB Layout 11/40/2011 5:2510... - name lbx
i @co 1KB Layout 11/10/2011 5:25:33.. - CDJbx
@ address 2B Layout 11/10/2011 5:28:23.. - address.Jbx
L.£2) Brother XX-XXX New Message.
Properties.
[ v
[No contents are selected.
Creates a new folder NUM
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0 Drag the template or other data that you want to transfer and place it in the new folder.

Transfer Function Specification

Maximum number of

Data type transferable items Restriction details
Template 255 B Each template can contain a maximum of 255 objects.
B Only *.csv files can be transferred.
Database 255
B Each *.csv file can contain a maximum of 65000 records.
Image B Only *.bmp files can be transferred.
(User-defined 255 B Monochrome *.bmp files are recommended.
character)

B The size limit is 832 x 832 pixels.

Note

You can confirm the available space in the transfer file memory by printing the Printer Setting Report. For
more information, see Print the Printer Information on page 91.
See [RomFree] for the available space®.

* The available space that appears in "RomFree = *******pyte" may be different from the actual available

space.

You can view the templates and other data by selecting:

B The folder in the [Configurations] folder
H [All Contents]

B One of the categories under [Filter], such as [Layouts]

When transferring multiple templates or other data, drag all the files you want to transfer and place them

in the new folder.

Each file is assigned a key number (memory location in the printer) when it is placed in the new folder.

& PC (Brother XX-X}XX)\Configurations - P-touch Transfer Manager
File Edit View Tool Help

o) = = a

Open Search Display Style

[E=RECR/E>3)

i Printer:
Al Printers !

Transfer Name |

Size [ Type [ Date [ KeyAssign [ Name

@) address
@
Recycle Bin @ name
/@ Search Results | @) number

[ 3 Transfer Manager
18] PC (Brother XX - XXXX)
B-%3 Configurations
o
4. Backups
29 Brother JX-XXXX

111072011 54502, [- |

2KB Layout 11/10/2011 5:42:32.., - address.lbx

1KB Layout 11/10/2011 555331, - name.lbx
1KB  Layout 11/10/2011 6:10:45... - number.lbx

For Help, press F1
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@ To change the key number assigned to an item, right-click the item, select [Key Assign], and then select
the key number you want.

& PC Brother XXX \Confgurations\ New Folder -P-touch Transfer Manager e
Fie Edit View Tool Help

> - & aQ e . N
Qe o Depysye  Chb—]

Transter Name Sze Type Date Key Assign Name
3] ABC Company B Layout AT 1262 1 ABC Companylbx
@l Brother KB Layout 1772016 10485... 2 Brotheribx
@P-touch B Layout LAT/2006 11044... 3 P-touch lbe

Backups
8] PC Brother XX000)
% Configurations

a0 Backups

Brother Industries Ltd. i
Phone: XXXXXXXXX 5
Fax: XXXXXXXXX

For Help, press FL % NUM

Note

Except for the data in databases, all data transferred to the printer is assigned a key number.

« If the template or other data transferred to the printer has the same key number as another template
already saved in the printer, the new template will overwrite the old one. You can confirm the templates
key number assignments saved in the printer by backing up the templates or other data. For more
information, see Back up Templates or Other Data Saved in the Printer on page 113.

* If the printer memory is full, remove one or more templates from the printer's storage memory. For more
information, see Back up Templates or Other Data Saved in the Printer on page 113.

@ To change the names of templates or other data that will be transferred, click the item you want, and
then type the new name. The number of characters used for the template names may be limited
depending on the printer model.

o Select the folder containing the templates or other data that you want to transfer, and then click
[Transfer]. A confirmation message appears.

& PC (Brother XX-XJXX)\Configurations - P-touch Transfer Manager felre ==
File Edit View Tool Help
<4 img Printer:
] ﬁ? @, = -
¥ = A E All Brinters -
Transfer « Open Search Display Style
=] P-touch Library Transfer Name [ size[ Type [ Date [ KeyAssign [ Name
-G All Contents @) address 2KB  Layout 11/10/2011 54232, - address.lbx
¥ Fiter Eleo | _ikBllaout 11070158500 [ ]CDibx
Recycle Bin @ name 1KB Layout 11/10/2011 5:53:3L.. - name lbx
@ Search Results Gl number 1KB Layout 11/10/2011 6:10:45.. - number.bx
[ 3 Transfer Manager
11 PC (Brother KX-XXXX)
B-%3 Configurations
H 3 Transfer
.. % Backups.
29 Brother XX -XXXX
“ il T
For Help, press F1 NUM
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Note

* You can also transfer individual items to the printer without adding them to a folder. Select the template or
other data that you want to transfer, and then click [Transfer].

* Multiple items and folders can be selected and transferred in one operation.

0 ciick [0KI.

P-touch Transfer Manager @

Files on the computer will be sent to the printer.
! % OKto continue?

Cancel

The selected items are transferred to the printer.
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Back up Templates or Other Data Saved in the Printer

Use the following procedure to retrieve the templates or other data saved in the printer and save it to a
computer.

@ !mportant
» Backed up templates or other data cannot be edited on the computer.

» Depending on the printer model, templates or other data backed up from one printer model may not be
able to be transferred to another printer model.

0 Connect the computer and the printer and turn the printer on.
The printer model name is displayed in the folder view.

If you select a printer in the folder view, the current templates and other data stored in the printer are
displayed.

9 Select the printer to back up from, and then click [Backup].
A confirmation message appears.

& Brother kX - XXXX- P-touch Transfer Manager ol e ==

File Edit View Tool Help

— = ¥ i Printer:
(#44 @j‘ O% J All Printers
sFer a Dper

Search Display Style

number 1KB Template 11/10/2011 20:57

Blname 1KB Template UAV 2057 5
P

=) 5KB Template UAVNL 05T 6

Bladdress 1KB Template 1AL 2057 T

7 Fitter
Recycle Bin

’lranﬁer Name [ Size [ Type. [ Date [ Key Assign Connected Database Name.
2 s

@ Search Results
[ 3 Transfer Manager
£330 PC (Brother XX-XXXK)
B-%3 Configurations
: (3 Transfer
4.y Backups
-8 PC (Brother XX-XXXX)
£-%) Configurations
¢ L[ Transfer
%) Backups

- T

For Help, press F1 NUM

@ click [OKI.
A new folder is created under the printer in the folder view. The folder name is based on the date and

time of the backup. All of the printer's templates and other data are transferred to the new folder and
saved on the computer.

P-touch Transfer Manager @

Printer data will be backed up onto the computer.
! % OKto continue?

Cancel
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Delete Printer Data

Use the following procedure to delete all templates or other data that are saved in the printer.

@ Important
This feature is only available when the computer and printer are connected via USB.

0 Connect the computer and the printer.
The printer model name appears next to a printer icon in the folder view.

9 Right-click the printer, and then select [Delete All].

& Brother {},- XX} X - P-touch Transfer Manager =5 ]
File Edit View Tool Help
=) ==t () = - Printer:
7 =) = - All Printers -
ansfer Backup e Search Display Style
] P-touch Library Transfer Name [ size[Type | Date | KeyAssign | Connected Database Name
i~ All Contents 8] number 1KE Template 10/2011 2057 2 E
™ name KB Template 1U/10/2011 2057 5
’t <D 5KB Template 1171042011 20:57 6
& address KB Template 1102011 20:57 7
-] PC (Brother KX - XXXX)
H 51 Configurations
i % Backups
P Delete All J
Printer Seftings. |
Properties...

[Multiple contents are selected.

A confirmation message appears.

P-touch Transfer Manager @

All data will be deleted from the printer.
% OKto continue?

Cancel

@ click [OK].
All templates and other data saved in the printer are deleted.
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Create Transfer Files and Transfer Package Files

You can use P-touch Transfer Manager to save template data, which was created using P-touch Editor, in
the .blf or .pdz format. You can transfer these files in this format to a printer, from a computer or mobile device.
You can also print files in BLF format when the printer is in mass storage mode.

0 Create the template using P-touch Editor, and then transfer it to P-touch Transfer Manager.
For more information, see Transfer the Template to P-Touch Transfer Manager on page 106.

9 Without connecting the printer to the computer, select [Configurations] in the P-touch Transfer Manager
window, and then select the template to save.

Note

You can select multiple templates at the same time.

0 Click [File] > [Save Transfer File].

@ Important
The [Save Transfer File] button appears only if the printer is disconnected from the computer or offline.

Note

* If you click [Save Transfer File] after selecting [Configurations], all templates in the folder are saved as
the BRAdmin file (.blf) or Transfer Package file (.pdz).

* You can combine multiple templates into a single BRAdmin file (.blf) or Transfer Package file (.pdz).

e In [Save as type], select the format in which to save the template, and then type in the name and save
the template.
Select the BLF format when printing using the mass storage mode or connecting your mobile device to
the printer using Wireless Direct or Wi-Fi, and select the PDZ format when connecting using Bluetooth.
The templates are saved as a BRAdmin file (.blf) or Transfer Package file (.pdz).
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Use of P-touch Library

This program allows you to manage and print P-touch Editor templates.

Start P-touch Library

For Windows 10 / Windows Server 2016 (RJ-4250WB):
Click [Start] > [P-touch Library 2.3] under [Brother P-touch)].

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2
(RJ-4250WB):

Click [P-touch Library 2.3] on the [Apps] screen.
For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB):
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Tools] > [P-touch Library 2.3].

When P-touch Library starts, the main window appears.

Main window

All Contents - P-touch Libra [ )
1 File Edit View Tool Help
= =
Q) i [
N
Search Display Style
— 4
3—
J
Mo contents are selected. )
— 5
J J
For Help, press F1 NUM

1 Menu bar
Provides access to all available commands, which are grouped under each menu title ([File], [Edit],
[View], [Tool], and [Help]) according to their functions.

2 Toolbar
Provides access to frequently used commands.

3 Folder list

Displays a list of folders. When you select a folder, the templates in the selected folder are displayed in
the templates list.
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4 Templates list
Displays a list of the templates or other data in the selected folder.

5 Preview

Displays a preview of the templates or other data selected in the templates list.

Explanations of the Toolbar Icons

Icon Button name Function

|__-'33’ Open Opens the selected template.

!

@ Print Prints the selected template with the printer.

' \, Search Allows you to search for templates registered to P-touch Library.
[=i Display Style Changes the file display style.
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Open and Edit Templates

Select the template you want to open or edit, and then click [Open].

& All Contents - P-touch Library
File Edit View Tool Help

(S

[E=RECE S>3

aQ H-

Open Print Search Display Style
[ P-touch Library Name. Size Date Location
%‘ ‘;” (”"“g"“ [F]ABC Companybx | 1KB | rs\User\Documents\My Labels\ABC Company.lbx
'EQ :‘y‘he“ " s @) Brotherdbx IKB 11/.. CAUsers\User\Documents\My Labels\Brother.lbx
earch Results @) P-touch.lbx 2KE 11f.. C\Users\User\Documents\My Labels\P-touch.lbx
4 i ;

For Help, press F1

The program associated with the template starts, and lets you edit the template.
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Print Templates

Select the template you want to print and then click [Print].

& All Contents - P-touch Library
File Edit View Tool Help

[E=RECE S>3

(S

Open Print

Q =-

Search Display Style

FE] P-touch Library
(E3 ANl Contents
- RecycleBin
S0 search Results

Size Date Location

Name

[7148C Companydbx | 1KB[11/... [ CAUsers\User\Documents\My Labels\ABC Company.lbx
(@ Brother.bx 1KE 11/, Ci\Users\User\Documents\My Labels\Brother.lbx
@) P-touch.lbx 2KE 11/.. CA\Users\User\Documents\Mly Labels\P-touch.lbx

<

i

ABC Company
Phone XXXXXXXXX

For Help, press F1

The connected printer prints the template.
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Search for Templates

You can search for templates registered to P-touch Library.

0 Click [Search].

The [Search] dialog box appears.

& Al Contents - P-touch Library
File Edit View Tool Help

&
Open Print

aQ =H-

Search Display Style

] P-touch Library
Contents

For Help, press F1

@] ABC Company.lbx 1KB 11/..
@) Brotherlbx 1KE 11/
@) P-touch.lbx e 11

Name Size Date Location

ser\Documents\My Labels\ABC Company.lbx
ser\Documents\My Labels\Brother. b
| anelc\ Dtk I

Search

Multiple Parameters

(conmams

=

| [conmams

1zt @
1Wnms @

Close

ABC Company

Phone XXXXXXXXX

9 Specify the search criteria.
The following search criteria are available:

Settings

Details

Multiple Parameters

Determines how the program searches when multiple criteria are specified. If you select
[AND], the program searches for files that satisfy all of the criteria.
If you select [OR], the program searches for files that satisfy any of the criteria.

Name Allows you to search for a template by specifying the file name.
Type Allows you to search for a template by specifying the file type.
Size Allows you to search for a template by specifying the file size.
Date Allows you to search for a template by specifying the file date.

0 Click [Begin Search)].
The search begins and the search results are displayed.

0 Close the [Search] dialog box.

To confirm the search results, click [Search Results] in the folder view.
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Note

You can register templates to P-touch Library by dragging and dropping them into the [All Contents] folder
or to the folder list. You can also configure P-touch Editor to register templates to P-touch Library
automatically, using the following procedure:

1 From the P-touch Editor menu, select [Tools] > [Options].
2 In the [Options] dialog box, click [General] > [Registration Settings].
3 Select the timing for registering templates created with P-touch Editor, and then click [OK].
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Transfer Express

You can transfer templates to the printer using P-touch Transfer Express. First, the administrator creates a
template, and then distributes it together with P-touch Transfer Express. You can then use P-touch Transfer
Express to transfer the template directly to the printer.

To download the latest version of P-touch Transfer Express, visit support.brother.com and go to your model's
[Downloads] page.

@ Important

» To transfer the file as a new template, specify a [Key Assign] number (in P-touch Transfer Manager) that
is not currently used. If the specified [Key Assign] number is already being used, the existing template
will be overwritten with the new one.

* This function requires a USB connection.

Administrator Users

Brother support website
1. sUbbort brother com I=1 Transfer Express j
P-touch P-touch P-touch
Editor Transfer Manager Transfer Express
3 & @ |
D :: D I::> D ptfilodil  PtTrExpexe  PATrExpini |::>
XxX.lbx xxx.lbx  xxx.pdz TR%M W;%m, XQI
| |1 | |
I 2 11 3 I I 4

Prepare P-touch Transfer Express

You must prepare P-touch Transfer Express for transferring templates to a printer.

@ Important
* The printer driver must be installed before using P-touch Transfer Express.

* P-touch Transfer Express is available only in English.

ﬂ To download the latest version of P-touch Transfer Express, visit support.brother.com and go to your
model's [Downloads] page.

9 Download P-touch Transfer Express to any location in Windows computer.

6 Decompress the downloaded file (.zip).
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How to Transfer Templates with P-touch Transfer Express

Transfer the Template to P-Touch Transfer Manager

0 In P-touch Editor, open the template you want to use.

9 Click [File] > [Transfer Template] > [Transfer].

@) P-touch Editor - [Layoutl]
ﬂ Edit View Insert Format Tools Layout Window Help

§

Al

ar

i

Mew... Ctrl+M . |
Open... Ctrl+ O j L
rame Image Favm

Close I
Save Ctrl+S & A h \\ v I:‘ h E
Save As... ||:||“||“||“||“
Export
Transfer Temnplate... » Transfer... -
Database 3 e

1

The template is transferred to P-touch Transfer Manager.
P-touch Transfer Manager automatically starts up.

Note

* For Windows 10 /Windows Server 2016 (RJ-4250WB):
The template can also be transferred to P-touch Transfer Manager by clicking [Start] > [Brother P-touch]
> [P-touch Transfer Manager 2.3] to start P-touch Transfer Manager, and then dragging the .Ibx file onto
the P-touch Transfer Manager window.

* For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2

(RJ-4250WB):

The template can also be transferred to P-touch Transfer Manager by clicking [P-touch Transfer

Manager 2.3] on the [Apps] screen to start P-touch Transfer Manager, then dragging the .Ibx file onto the
P-touch Transfer Manager window.

* For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB):

The template can also be transferred to P-touch Transfer Manager by clicking [Start] > [All Programs] >

[Brother P-touch] > [P-touch Tools] > [P-touch Transfer Manager 2.3] to start P-touch Transfer

Manager, then dragging the .Ibx file onto the P-touch Transfer Manager window.
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How to Transfer Templates with P-touch Transfer Express

Save the Template as a Transfer Package File (.pdz)

To create a file in a format that can be used by P-touch Transfer Express, save the template as a Transfer

Package file (.pdz).

0 In the folder view, select [Configurations].

-

-ﬁ PC (Brother XX-X000 ) Configurations - P-tou
Eile Edit View Tool Help

te &)

7] P-touch Library
..... All Contents
&7 Filter

..... i Recycle Bin

[; Transfer Manager
=M PC (Brother XX-300(X)

B Coiguron]

------ Backups
& p

9 Select the template you want to distribute.

Transfer Mame

ﬂ Layoutl

i

-ﬁ PC (Brother X-XXXX "\ Configurations - P-tou
File Edit View Tool Help

t =)

7] P-touch Library
- All Contents

-7 Filter

[; Transfer Manager
-S| PC (Brother 3-2000()

------ %) Configurations

Mame

Layoutl.lbx
Layout?.|bx
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How to Transfer Templates with P-touch Transfer Express

@ Click [File] > [Save Transfer File].

-

-ﬁ PC (Brother XX-XXXX)\Configurations - P-tou
Edit View Tool Help

Open... Ctrl+0 ;;}?

Transfer
Sawve Transfer File... :arne
Backup 1.lbx
Import... 2.lbx
Export...

@ Important
The [Save Transfer File] button appears only if the printer is disconnected from the computer or offline.

Note

« If you click [Save Transfer File] after selecting [Configurations] or a created folder, all templates in the
folder are saved as the Transfer Package file (.pdz).

* You can combine multiple templates into a single Transfer Package file (.pdz).

0 Type in the name, and then click [Save].
& Save As &J

@Qv‘l?eslﬁop » - ‘ &,l | Search Desktop o]

Organize » New folder B [z

=
= Mame Size Item type Date modified
I Favorites E

Bl Desktop
& Downloads

|
. Libraries
'8 Computer

1=l Recent Places € Network

7 Libraries
}_{ Documents
3? Music
|| Pictures

B videos

% Computer
&, Local Disk(C)  _

File name: Layoutl

Save as type: | Transfer Package File (*.pdz)}

. Hide Folders [ sve | [ conca |

The template is saved as a Transfer Package file (.pdz).
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How to Transfer Templates with P-touch Transfer Express

Distribute the Transfer Package File (.pdz) and P-Touch

Transfer Express to the User

Note

If you already have P-touch Transfer Express downloaded, it is not necessary for the administrator to send
the Transfer Express folder. In this case, you can simply move the distributed Transfer Package file to the
downloaded folder, and then double-click [PtTrExp.exe].

0 Move the Transfer Package file (.pdz) to the downloaded folder.

Q'\;" | J < Transfer Express

‘ Organize ~ A Wiews - (& Bum ol

Date modified Type

< @ Q3

- -

ptfilot.dll  PtTrExp.exe PtTrExp.ini  TRDRV.dII

x |"'f | | Search

Size

R &
unzip32.dil

Layoutl.pdz

@ Distribute all the files in the downloads folder to others.

Layoutl.pdz
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How to Transfer Templates with P-touch Transfer Express

Transfer the Transfer Package File (.pdz) to the Printer

Using the P-touch Transfer Express software received from the administrator, you can transfer the Transfer
Package file (.pdz) to the printer.

@ !mportant
Do not turn the power off when transferring templates.

0 Turn the printer on.
9 Using a USB cable, connect the printer to the computer.
0 Double-click [PtTrExp.exe], which was received from the administrator.

0 Transfer a Transfer Package file (.pdz) to the printer.
B Transferring a single Transfer Package file (.pdz)

1 When there is a single Transfer Package file (.pdz) within the folder containing [PtTrExp.exe], click
[Transfer].

(] P-touch Transfer Express (=3

2 Click the Transfer button to begin transferring data
to the printer.

Transfer Package File : Layoutl.pdz

Exit

2 The transfer of the Transfer Package file begins.

P-touch Transfer Express Lﬁ_a-J

Transferring Layoutl
7 %
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How to Transfer Templates with P-touch Transfer Express

B Transferring multiple Transfer Package files (.pdz)

1 When there are either multiple or no Transfer Package files (.pdz) within the folder containing

[PtTrExp.exe], click [Browse].

(] P-touch Transfer Express

2 Select the Transfer Package file you want to transfer, and then click [Open].

= Select the Transfer Package file to be transferred to the printer.
@ Then, click the Transfer button to begin transferring.

Transfer Package File:

| Browse...

%= Transfer Exit

= Open (=3
Look in: | | Transfer Express j EF '
= Name Date modif.. Type Size
Hew‘:}:aws i, |Layoutl.pdz :

|| Layout2.pdz

Desktop

i

CredeclNagoya

LY

-

Computer

[ W
==
Network

File name: |La=,'0ut1 pdz j Open

Files of type: |T|an5fer Package file (" pdz) j Cancel

3 Click [Transfer].

(] P-touch Transfer Express (=3

= Select the Transfer Package file to be transferred to the printer.
@ Then, click the Transfer button to begin transferring.

Transfer Package File:

| C:\Users\xoot\Desktop)\ Transfer Express\Layoutl.pdz Browse...

%5 Transfer Exit

128



How to Transfer Templates with P-touch Transfer Express

4 Click [Yes].

P-touch Transfer Express E3

5 The transfer of the Transfer Package file begins.

P-touch Transfer Express ﬁ
=1 =
Transferring Layoutl
7%
O ciick [OK].
[ P-touch Transfer Express ﬁ ]

The transfer of the Transfer Package file is completed.
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How to Update P-touch Software

The software can be upgraded to the latest available version using the P-touch Update Software.

Note

* The actual software and the contents of this manual may differ.
* Do not turn the power off when transferring data or updating firmware.

Update P-touch Software

@ Important
Before updating software, install the printer driver.

0 For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [Brother P-touch] > [P-touch Update Software], or double-click [P-touch Update
Software] on the desktop.

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2
(RJ-4250WB)

Click [P-touch Update Software] on the [Apps] screen or double-click [P-touch Update Software] on
the desktop.

For Windows 7 / Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Double-click the [P-touch Update Software] icon.

Note

The following method can also be used to start the P-touch Update Software.
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Update Software].
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How to Update P-touch Software

9 Click the [Computer software update] icon.

i P-touch Update Software

m@g

button.

Which update do you wish to chedk for?
Click one of the buttons below.
h Details on the information that is updated appears beside each

C

Machine update

Firmware updates and other data can be downloaded
from the website, and transfered to the machine.

software

“Y'ou can upgrade the computer software, and install

.@ additonal data.

9 Select the [Printer] and [Language], select the check box next to the software you want to update and

then click [Install].

& P-touch Update Software

)

File Tools Help

The updated computer software and additional data

will be installed.
Select the desired items, and then dick the “Install” button.

Printer: I K - 000 v]
Language: IEninsh[Unibed States) A ]
File list: Refresh List

Title
O —@ P-touch Editar

Version Size L

S.0.122 22,8 MB

w

[

£ Click here for details

[ ® sl | [ cese ]

Q A message appears to indicate the installation has finished.
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How to Update P-touch Software

Update the Firmware

@ Important
» Before updating the firmware you must install the printer driver.

* Do not turn the power off when transferring data or updating firmware.
« If other software is running, exit the software.

0 Turn the printer on and connect the USB cable.

9 For Windows 10 / Windows Server 2016 (RJ-4250WB)
Click [Start] > [Brother P-touch] > [P-touch Update Software], or double-click [P-touch Update
Software] on the desktop.

For Windows 8 / Windows 8.1 / Windows Server 2012 (RJ-4250WB) / Windows Server 2012 R2
(RJ-4250WB)

Click [P-touch Update Software] on the [Apps] screen or double-click [P-touch Update Software] on
the desktop.

For Windows 7 /| Windows Server 2008 (RJ-4250WB) / Windows Server 2008 R2 (RJ-4250WB)
Double-click the [P-touch Update Software] icon.

Note

The following method can also be used to start the P-touch Update Software.
Click [Start] > [All Programs] > [Brother P-touch] > [P-touch Update Software].

Updaies

S
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How to Update P-touch Software

6 Click the [Machine update] icon.

4 P-touch Update Software B

Which update do you wish to chedk for?

Click one of the buttons below.

Details on the information that is updated appears beside each
button.

&

Machi

Firrware updates and ather data can be downloaded
frorn the website, and transferred to the machine.

&

[« software

“f'ou can upgrade the computer software, and install
additonal data.

@l

ﬂ Select the [Printer], make sure that [The machine is connected correctly.] message appears, and
then click [OK].

4 P-touch Update Software E N [E=EEm
The status of the machine connection will be checked.
Select the model being used.

Printer: [ - 00 - ]]

The machine is connected correctly. |

Click the "OK” button.

*If multiple units of the same model are connected, all operations will be
applied to all units.

= = |
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How to Update P-touch Software

@ Select the [Language], select the check box next to the firmware to be updated, and then click
[Transfer].

@ !mportant
Do not turn the printer off or disconnect the cable during data transfer.

& P-touch Update Software E@g

File Tools Help

The latest compatible software and data will be
H transferred to the machine.
'ﬁ' Select the desired items, and then dick the “Transfer” button.

Printer: - 000
Language: I[English(L.lnitEd States) s l
File list: Refresh List

th

Version Size

[ ° Transfer ] [ Close ]

@ Check the content to be updated, and then click [Transfer] to begin the update.
The firmware update begins.

Note

Do not turn the printer off or disconnect the cable during the update process.
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Wireless Network (RJ-4250WB Only)

Network Features

The printer can be shared on an IEEE 802.11a/b/g/n wireless network using the internal network print server.
The print server supports various functions and methods of connection on a network supporting TCP/IP,

depending on the operating system you are running.
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Wireless Network (RJ-4250WB Only)

How to Change the Printer's Network Settings
(IP Address, Subnet Mask and Gateway)

Use of BRAdmin Light Utility

The BRAdmiIn Light utility is designed for the initial setup of Brother network connectable devices. It can also
search for Brother products in a TCP/IP environment, show the status and configure basic network settings,
such as the IP address.

Install BRAdmin Light
0 Visit our website (install.brother) and download the installer for the software and manuals.

9 Double-click the downloaded .exe file and follow the on-screen instructions to proceed with the
installation. In the dialog box for selecting which items to install, select BRAdmin Light.

Note

* If you require more advanced printer management, use the latest Brother BRAdmin Professional utility
available as a download from the Brother support website at support.brother.com.

* If you are using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure
that you can print, re-enable them.

» The node name appears in the current BRAdmin Light window. The default node name of the print server
in the printer is “BRWXxxxxxxxxxxx”. (“xxxxxxxxxxxx” is based on the printer's MAC Address / Ethernet
Address.)

* If required, enter the password "initpass".

Set the IP address, Subnet Mask and Gateway using BRAdmin Light

0 Start the BRAdmin Light utility.
B Windows 10 / Windows Server 2016:
Click [Start] > [BRAdmin Light] under [Brother].
B Windows 8 / Windows 8.1 / Windows Server 2012 / Windows Server 2012 R2:
Click [BRAdmin Light] icon on the [Apps] screen.
B Windows 7 / Windows Server 2008 / Windows Server 2008 R2:
Click [Start] > [All Programs] > [Brother] > [BRAdmin Light] > [BRAdmin Light].

9 BRAdmin Light searches for new devices automatically.
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Wireless Network (RJ-4250WB Only)

@ Double-click the new, unconfigured device.

[]

[F=3 [Eon )

I@% @’ﬁs@%ﬁ%
=

other

Note

If you do not use a DHCP/BOOTP/RARP server, the device appears as [Unconfigured] in the BRAdmin
Light utility screen.

0 Select [STATIC] for the [Boot Method]. Enter the [IP Address], [Subnet Mask] and [Gateway] (if
needed) of your print server.

iy S - ==

1| |

@ ciick [0KI.

@ With a correctly programmed IP address, the Brother print server appears in the device list.
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Wireless Network (RJ-4250WB Only)

Other Management Utilities

The printer can be used with the following management utilities in addition to the BRAdmin Light utility. You
can change your network settings using these utilities.

Use Web Based Management (Web Browser)

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text
Transfer Protocol). (See Configure the Printer Settings Using Web Based Management (Web Browser)
on page 140.)

Use of the BRAdmin Professional Utility

BRAdmin Professional is a utility for more advanced management of network connected Brother devices.
This utility can search for Brother products on your network, and show the device status from an easy to read
Explorer style window that changes colour to represent the status of each device.

Note

* Please use the latest version of the BRAdmin Professional utility available as a download from the Brother
support website at support.brother.com.

» The node name appears in the current BRAdmin Professional window. The default node name is
“BRWxXXXXXXXXXXXX”. (“XxXxXxXxxXxxxX” is based on the printer's MAC Address / Ethernet Address.)

* If you are using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure
that you can print, re-enable them.

* If required, enter the password "initpass".

138


https://support.brother.com

Wireless Network (RJ-4250WB Only)

Web Based Management

You can use a standard web browser to manage a printer on your network using HTTP. When using Web
Based Management, you can do the following:

B Display the printer status information

B Change network settings such as TCP/IP information

B Display software version information of the printer and print server
B Change network and printer configuration details

Note

* We recommend Microsoft Internet Explorer 11/Edge for Windows. Make sure that JavaScript and Cookies
are always enabled in whichever browser you use.

» The default login password to manage printer settings is initpass. We recommend you change it to protect
your printer from unauthorized access.

To use Web Based Management, your network must use TCP/IP, and the printer and Windows computer
must have a valid IP address.
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Wireless Network (RJ-4250WB Only)

Configure the Printer Settings Using Web Based Management
(Web Browser)

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text
Transfer Protocol).

0 Type http://printer ip address/ into your browser. (Where printer ip address is the IP
address or the print server name.)
B For example (if the printer's IP address is 192.168.1.2.):
http://192.168.1.2/

Note

If you have edited the hosts file on your computer or are using a Domain Name System, you can also enter
the DNS name of the print server. As the print server supports TCP/IP and NetBIOS, you can also enter
the NetBIOS name of the print server. You can find the NetBIOS name on the printer settings page. The
NetBIOS name assigned is the first 15 characters of the node name and by default it appears as
“BRWxxxxxxxxxxxx” where “xxxxxxxxxxxx” is the Ethernet address.

9 You can now change the print server settings.

Note

Set a password

We recommend to change a login password to prevent unauthorised access to the Web Based
Management.

Click [Administrator].
Enter the password you want to use (up to 32 characters).

Re-enter the password in [Confirm new password] box.

Click [Submit].
The next time you access Web Based Management, enter a password in the [Login] box, and then

click g3
After configuring the settings, logout by clicking .

You can also set a password by clicking [Please configure the password] on the printer's web page if
you are not setting a login password.
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Appendix

Printer Maintenance

Product Specifications

Battery Charger (Optional:PA-BC-003)
Linerless Platen Kit (Optional:PA-LPR-001)
Charging Cradle (Optional:PA-CR-002)
Troubleshooting
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Printer Maintenance

Maintenance of the printer may be carried out as required. However, some environments may require more
frequent maintenance (for example, dusty environments).

Exterior Maintenance

Wipe any dust and marks from the main unit using a soft, dry cloth.
Use a cloth slightly dampened with water on difficult to remove marks.

Note

Do not use paint thinner, benzene, alcohol, or any other organic solvent.
These may deform or damage the case of the printer.

Print Head Maintenance

Wipe the print head with a lint-free cloth dipped in isopropyl alcohol or ethanol. Carry out the maintenance
frequently.

1 Print head

Note

Use according to the manufacturer's safety guidelines, as applicable.
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Printer Maintenance

Roller Maintenance

Wipe the roller with a lint-free cloth dipped in isopropyl alcohol or ethanol. After cleaning the roller, make sure
that no lint or other material remains on the roller.

1 Roller

Note

Use according to the manufacturer's safety guidelines, as applicable.

Paper Exit Slot Maintenance

If adhesive accumulates at the paper exit slot and media becomes jammed or if the paper exit slot becomes
dirty, wipe the paper exit slot with a lint-free cloth dipped in isopropyl alcohol or ethanol.

1 Paper exit slot

Note

Use according to the manufacturer's safety guidelines, as applicable.
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Printer Maintenance

Linerless Platen Maintenance

When using the Linerless Platen Kit, paper dust may stick to the print head. Clean the print head regularly
with a lint-free cloth or cotton swab dipped in isopropyl alcohol or ethanol as shown in the illustration.

1 Print head
After cleaning the print head, make sure that no lint or other material remains on the print head.

Note

Do not clean the roller of the linerless platen (See Linerless Platen Kit (Optional:PA-LPR-001)
on page 153) to prevent its deterioration.
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Product Specifications

Items

Printing

Printing technology

Direct Thermal

Print resolution

203 dpi x 203 dpi

Print speed* Maximum 127 mm/s
Maximum 76 mm/s (When linerless media is used.)
Maximum print width 104 mm
Maximum print length 3000 mm
Minimum print length 12.7 mm

Size

Weight (including battery)

Approximately 850 g

Dimensions Approximately 153 mm (W) x 159 mm (D) x 68 mm (H)
Interface
USB USB Ver. 2.0 (Full Speed) (mini-B)
Bluetooth Version 4.2
Supported profiles: SPP, OPP, HCRP, GATT
Supported protocol: iAP
Wireless LAN IEEE 802.11g/n (Wireless Direct)

(RJ-4250WB only)

IEEE 802.11a/b/g/n (Infrastructure Mode)
WPS 2.0

Environment

Operating temperature

Operate:

The battery: -20°C to 55°C

AC adapter: -10°C to 40°C

Car adapter: -10°C to 50°C

10°C to 30°C (When linerless media is used.)

Charge:

0°C to 40°C (recommendable: 5°C to 35°C)

If the internal temperature of the battery is out of this range, charging may stop.

Operating humidity

10% to 90% (No condensation, Maximum wet bulb temperature: 27°C)

20% to 50% (No condensation, Maximum wet bulb temperature: 27°C) (When
linerless media is used.)

Storage temperature

-20°C to 60°C

Storage humidity

10% to 90% (No condensation, Maximum wet bulb temperature: 45°C)
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Product Specifications

Items

Power supply

Battery Rechargeable Li-ion battery: 7.2 V

Adapter (optional) AC adapter (15 V)

Car adapter (optional) Cigarette lighter car adapter (12 V (DC))

Maximum number of labels 10,000 labels *

Charging time 4 hours (when charging at 23°C with the printer turned off, and using a new
battery)

Media specification

Media type Receipt, Gap/Black mark Label, Tag, Linerless (Optional)

Media width 45 mm to 114 mm

Thickness Receipt: 0.058 mm to 0.090 mm

Tag: 0.090 mm to 0.135 mm
Label: 0.080 mm to 0.170 mm

Roll outside diameter (max) 58 mm
Core diameter (min) Receipt: 12.7 mm
Label: 25.4 mm
Media sensor Transmissive, Reflective

Compatible operating systems
See support.brother.com for a complete and updated list of software.

*Using Brother's print test data (7% coverage, 102 x 29 mm) at 23°C when performing continuous printing
using a USB connection with a new, fully-charged battery.
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Battery Charger (Optional:PA-BC-003)

Parts Description

Charge indicator

Battery charging terminals
Battery compartment
Locking expansion slot
DC connector OUT

DC connector IN

Locking expansion hook
DC cord

0 N OO O b~ WODN -

Specifications

Charge time: Approximately 4 hours*

Charge temperature: 0°C to 40°C (recommendable: 5°C to 35°C)

Operating humidity: 10% to 90% (No condensation)

* Varies depending on operating environment and the condition of the battery.
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Battery Charger (Optional:PA-BC-003)

How to Charge Batteries

The AC adapter (PA-AD-600), which is sold separately, is required for charging.
To charge the rechargeable Li-ion battery, use the charger together with the AC adapter (PA-AD-600).
The charger (PA-BC-003) cannot recharge the battery alone.

0 Connect the AC adapter to the charger's DC connector IN, and then connect the AC power cord to the
AC adapter.

Note

Insert the AC adapter through the opening in the battery charger as shown in the illustration. Install the AC
adapter so the battery charger does not press on it.

9 Connect the AC power cord to a nearby electrical socket.

9 Align the charging terminals of the charger and the battery, and then insert the battery.
The indicator lights in orange when the battery is charging.

0 The charge indicator will turn off when charging is complete.
You can then remove the battery.
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Battery Charger (Optional:PA-BC-003)

Wall Mounting

The units can be wall-mounted with two screws per unit. Install the screws vertically with the spacing shown
below. Ensure the screws are correctly secured with wall anchors or studs. The cavity must face upward (as
shown) to hold the battery in place.

1: Dia. 3-4.5mm

2: Dia. 8.5 mm or less
3:12.2 mm or more
4:445-47.5 mm

A: Wall material
B: Wall-mount slots
C: Screw

Use the Insert Nuts

Insert nuts are provided on the base of the battery charger. Using these insert nuts, screws may be fastened
to a board.

When fastening with screws, use the following types of screws.
B M2.6 Pitch 0.45 Screws
B Screws that are 3.5 mm to 7 mm longer than the thickness of the board

Note

* When attaching to a vertical board, the method of installation is the same as wall mounting (See Wall
Mounting on page 149).

» Be sure not to pinch the cables between the base of the battery charger and the board.
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Battery Charger (Optional:PA-BC-003)

N
W

1 27.7 mm
2 38 mm
3 95mm
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Battery Charger (Optional:PA-BC-003)

Connect Multiple Battery Chargers

Up to four battery chargers can be connected in-line together.

0 Insert the locking expansion hook on one Li-ion battery charger into the slot in another Li-ion battery
charger until it locks into place.
Then, connect the AC adapter to the first battery charger.

9 Connect one end of the included DC cord to the DC connector OUT of the first battery charger and
connect the other end of the DC cord to the DC connector IN of the second battery charger.

Note

» Connect the AC adapter and DC cord through the opening in the battery charger as shown in the
illustration.

Install the AC adapter and DC cord so the battery charger does not press on them.

* When connecting battery chargers, it is recommended to use self-tapping screws (M2.6 x 6 mm) (not
included) to firmly secure the battery chargers to one another.
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Battery Charger (Optional:PA-BC-003)

Disconnect the Battery Chargers

0 Disconnect the DC cord and AC adapter from the battery chargers.

@ Push the tab on the locking expansion hook to release the lock, and then disconnect the battery
chargers.
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Linerless Platen Kit (Optional:PA-LPR-
001)

This printer is compatible with linerless media.

Parts Description

Linerless Platen Screws (2)

&
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Linerless Platen Kit (Optional:PA-LPR-001)

Install the Linerless Platen

0 Push the roll cover release lever to open the roll compartment cover.

1 Roll cover release lever

9 Remove the default platen by removing the two screws shown in the illustration.

A CAUTION

Do not touch the blade when removing the default platen.

Note

It is recommended that the tightening torque be 0.55+0.049 N-m.

e Install the Linerless Platen, and fasten it using the two screws included in the Linerless Platen Kit.
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Linerless Platen Kit (Optional:PA-LPR-001)

Note

The lower tear bar cannot be used when the Linerless Platen is installed.

0 Set [Linerless] to [On] in the [Advanced] tab of the Printer Setting Tool.

Note

* When [Linerless] is set to [On], [Tear Bar]in[Settings]and [Auto Detect]in [Media] cannot be
selected on the printer's LCD.

» For best performance, make sure the paper's head margin is at least 9 mm.

* When using the Linerless Platen, paper dust may stick to the print head. Clean the print head regularly
(see Linerless Platen Maintenance on page 144).
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Charging Cradle (Optional:PA-CR-002)

Parts Description

Charging Cradle Charging Cradle Terminal Screws (2 each)
Attachment

Charging cradle terminals
Eject button
DC connector IN

A WODN -

USB port (Allows to print from a mobile device or a computer by connecting it to the docking station using
a USB cable.)

Specifications

Charge time: About 4 hours*

Charge temperature: 0°C to 35°C (recommendable: 5°C to 35°C)

Operating temperature:

AC adapter: -10°C to 40°C

Car adapter: -10°C to 50°C

Operating humidity: 10% to 90% (No condensation)

* Varies depending on operating environment and the condition of the battery.
Note
» The charging cradle can be used without a battery as a power supply or for printing.
» Do not turn the printer on and the charging cradle simultaneously.

» Sequential printing and the mass storage mode are not supported when the charging cradle is used to
print.

* It is recommended to change the setting of the printer driver to [After one page of data is received] in
[Other] tab when printing from the charging cradle.
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Charging Cradle (Optional:PA-CR-002)

How to Charge Batteries

The AC adapter (PA-AD-600, sold separately) can be used for providing power from an electrical socket to
the charging cradle and charging the battery if installed.

The Charging Cradle (PA-CR-002) cannot recharge the battery alone.

0 Connect the AC adapter to the charging cradle's DC connector IN, and then connect the AC power cord
to the AC adapter.

D)

9 Connect the AC power cord to a nearby electrical socket.

9 Remove the charging cradle terminal cover with a flathead screwdriver.
Install the charging cradle terminal attachment to the printer using the charging cradle terminal
attachment and screws included with the charging cradle.

Note

Install the charging cradle terminal attachment. Make sure the notched corner is aligned correctly.

0 Align the charging cradle terminals of the charging cradle and the printer, and then press the printer down
and onto the charging cradle until the latches lock it firmly in place.
The printer’s battery indicator lights in orange when charging.
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Charging Cradle (Optional:PA-CR-002)

@ The printer’s battery indicator will turn off when charging is complete.

Printer Removal

Push the eject button on the back of the charging cradle and lift the printer and remove it from the charging
cradle.

1 Eject button
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Charging Cradle (Optional:PA-CR-002)

Wall Mounting

The charging cradle can be wall mounted. Affix it to the wall using four screws, as shown in the illustration.
Make sure you install the charging cradle in the correct direction so that the printer will not fall.

Use screws with the following dimensions: Length: 25 mm or more, Diameter: 9.8 mm or less

1 Height: 30 mm
2 Width: 38.1 mm
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Troubleshooting

Overview

This chapter explains how to resolve typical problems you may encounter when using the printer. If you have
any problems with the printer, first make sure you have performed the following tasks correctly:

B Remove all protective packaging from the printer.

B Close the roll compartment cover completely.

B Install the battery (see Install the Battery on page 20).

B Connect the AC adapter (see How to Recharge the Battery with the AC Adapter (Optional) on page 23).
B Connect the car adapter (see How to Recharge the Battery with the Car Adapter (Optional) on page 24).

B Install and select the correct printer driver (see Install the Printer Driver and Software (When Using a
Computer) on page 35).

B Connect the printer to a Windows computer or mobile device (see Connect the Printer to a Computer or
Mobile Device on page 36).

B [nsert the roll correctly (see Insert the Roll on page 26).

If you still have problems, read the troubleshooting tips in this chapter. If, after reading this chapter, you are
unable to resolve your problem, visit the Brother support website at support.brother.com.

Printing Problems

Problem Solution

The printer does not print, or there is | M Is the cable loose (when you are using a USB cable)?
a printing error.

Check that the cable is connected securely.
B |s the roll installed correctly?
If not, remove the roll and reinstall it.
(See Insert the Roll on page 26.)
W |s there enough roll remaining?
If not, install a new roll.
M |s the roll compartment cover open?
Check that the roll compartment cover is closed.
B Has a print error or transmission error occurred?

Turn the printer off and on again. If the problem still occurs, contact your
Brother dealer.
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Troubleshooting

Problem

Solution

The printer does not feed paper.

B |s there dirt or lint on the roller preventing it from rolling freely?
Clean the roller. (See Roller Maintenance on page 143.)

B Check that the ejection path of the paper is not blocked.

B Check that the roll is set correctly by removing the roll and installing it again.
(See Insert the Roll on page 26.)

B Ensure that the roll compartment cover is closed correctly.

The printer feeds paper
continuously.

B Open the roll compartment cover.

B Press the d) (Power) button or *© (Back) button to cancel the print job.

B Turn the printer off.

The printer does not pause between
labels.

B Check that you entered the media information correctly. You can set the
media information using [Paper Size Setup] in the Printer Setting Tool.

B Check that the sensor is not dirty. If the sensor is dirty, wipe it with a dry
cotton swab.

1 Media sensor

B Check that there are no items blocking the sensor.
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Troubleshooting

Problem

Solution

When printing via the USB cable, the
printer repeatedly pauses and then
continues printing.

Is the printer set for sequential printing?
If so, set print mode to buffered printing.

For Windows 10 / Windows Server 2016 (RJ-4250WB):

Open printer properties from [Control Panel] - [Hardware and Sound] -
[Devices and Printers], right-click the printer you want, and select [Printing
preferences].

Click the [Other] tab and select the option [After one page of data is
received].

For Windows 7 / Windows 8 / Windows 8.1 / Windows Server 2008 R2
(RJ-4250WB) / Windows Server 2012 (RJ-4250WB) / Windows Server 2012
R2 (RJ-4250WB):

Open printer properties from [Devices and Printers], right-click the printer you
want, and select [Printing preferences]. Click the [Other] tab and select the
option [After one page of data is received].

For Windows Server 2008 (RJ-4250WB):

Open Printer Properties from [Control Panel] - [Hardware and Sound] -
[Printers], click the printer you want, and select [Select printing preferences].
Click the [Other] tab and select the option [After one page of data is
received].

An error occurs when the roll cannot
be fed to the beginning of the
printing.

If a feed error occurs, use the Paper Size Setup of the Printer Setting Tool to
assign the correct paper settings to the printer or click [Select Media]to
check whether correct media is set in the printer when RD roll is used.

Printed Image Problems

Problem

Solution

Printed paper contains streaks or
poor quality characters, or paper is
not fed correctly.

Is the print head or roller dirty?

Although the print head generally remains clean under normal use, lint or dirt
from the roller may become stuck on the printer head. If this occurs, clean the
roller (see Roller Maintenance on page 143).

The print quality is poor.

B |s there dust or dirt on the print head or roller preventing it from turning
freely?

Clean the print head or roller (see Print Head Maintenance on page 142 and
Roller Maintenance on page 143).

B Adjust the printing density. The print density can be specified in the Printer
Setting Tool.
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Troubleshooting

Problem

Solution

Printed barcodes cannot be read.

B Print labels so that barcodes are aligned with the print head as shown
below.

1 Print head
2 Barcode
3 Printing orientation
B Try using another barcode reader.

B Set [Print Speed] to a slower option. The print speed can be specified in the
Printer Setting Tool. (See Device Settings on page 70.)

B Adjust [Print Density]. The print density can be specified in the Printer
Setting Tool. (See Device Settings on page 70.)

B This printer is not designed exclusively for creating barcode labels. Always
check that barcode labels can be read by the barcode reader.

Printer Problems

Problem

Solution

The LED indicator or the LCD is not
lit.

B |s the battery inserted correctly?

Check that the battery is inserted correctly. If itis, check that the battery has
sufficient charge remaining.

B |s the adapter cord connected properly?
Check that the cord is connected correctly.

B If the LED indicator or the LCD still does not light up, contact your Brother
dealer.

A data transmission error appears on
your computer.

M |s the correct port selected?

Check that the correct port is selected.
B |s the printer in cooling mode?

The message [Cooling]is displayed on the LCD.

Wait until the message disappears and then try printing again.
B Are there any unfinished print jobs?

If you try to print while other users are printing large amounts of data, the
printer is unable to accept your print job until the current print jobs are
completed. If this occurs, send the print job again after the other jobs are
completed.
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Troubleshooting

Problem

Solution

| want to reset the printer/delete the
data transferred from the computer.

To reset the printer, perform the following procedure:
1 Press the d) (Power) button to turn the printer off.

2 Press and hold the [ (Feed) / OK button and the (") (Power) button for
about five seconds.

3 While pressing the (') (Power) button, press the 1[* (Feed) / OK button six
times.

4 Release the (1) (Power) button.

All the transferred data from the computer will be deleted and the printer
settings will be reset to the factory settings.

| want to cancel the current print job.

Make sure that the printer is On, and then press the d) (Power) button or
9 (Back) button.

Print head, motor, or battery is too
hot.

The thermal head, motor, or battery is too hot.

B Head:
If the thermal head becomes too hot, it may produce imaging on the paper
in areas not intended to be printed. This condition is normal when printing
documents with a lot of “black” content.

The printer will stop and resume printing after the print head has cooled
down.

To avoid or delay this condition, print using a lighter density setting, reduce
the amount of black space being printed (for example, remove background
shading and colours in graphs and presentation documents), and make
sure that the printer has adequate ventilation and is not located in an
enclosed space.

B Motor or battery:
Do not use the printer continuously. If the printer is used continuously, the
motor or battery will become too hot. In this case, the printer will stop and
resume printing after the motor or battery has cooled down.

Note

This condition may occur more often when the printer is used at high altitude
(more than about 3,000 m) due to a lower air density available to cool the
printer.

Transferring the program failed.

The system will recover if the program is transferred again. To resolve the
issue, contact your Brother dealer or Brother customer service for assistance.
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Troubleshooting

Network Setup Problems

Problem

Solution

You are using security software

B Confirm your settings in the installer dialog box.

B Allow access when the security software alert message appears during the
printer installation.

Your security settings
(SSID/Network Key) are
incorrect

Make sure the network security settings are correct:

B See the instructions supplied with your Wi-Fi access point/router for information
on how to find the security settings.

B The default SSID (Network Name) may be your Wi-Fi access point/router's
manufacturer name or model number.

B Contact the manufacturer of your Wi-Fi access point/router or ask your Internet
provider or network administrator.

The printer cannot connect to the
mobile device using Wi-Fi or
Bluetooth.

The printer cannot print using Wi-
Fi or Bluetooth.

B Move the printer within about one metre of the mobile device when you
configure the Wi-Fi network settings.

B Move the printer to an obstruction-free area.

B If a wireless computer, Bluetooth-equipped device, microwave oven, digital
cordless phone, or other device is near the printer or the Wi-Fi access
point/router, move the device away from the printer or Wi-Fi access point/router.

You are using MAC Address
filtering

B You can confirm the MAC address by printing out the printer information. Press
and hold the TD (Feed) / OK button to print the printer information.
B Set the Wi-Fi access point/router so that the MAC address of the printer is

allowed for connections. For more information, see the instructions supplied
with your Wi-Fi access point/router.

Your Wi-Fi access point/router is
in stealth mode (not broadcasting
the SSID)

B Enter the correct SSID name during the installation or when using
[Communication Settings] in the Printer Setting Tool.

B Check the SSID name in the instructions supplied with your Wi-Fi access
point/router and set up your wireless network again.

The printer is not connected
correctly to the network.

Check the WLAN icon on the LCD.

The printer is already connected some wireless network. Check
the wireless network information and confirm to connect your Wi-
Fi access point/router correctly.

-
L]

. ))
. )))

The printer is searching for the network. Make sure the Wi-Fi
access point/router is available and wait a while. Then the printer
is still not connected, set up the printer's Wi-Fi connection again.

No icon The wireless network feature on your printer is off. Make sure that

the printer is in the mode you want to connect to.

I have checked and tried all of the
above, but still cannot complete
the wireless configuration.

Turn the printer off and on again. Then try and configure the Wi-Fi settings again.
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Troubleshooting

Cannot Print over the Network
Printer Is Not Found on the Network Even after Successful Installation

Problem

Solution

You are using security software

See Security Software Problems on page 166.

The printer is not assigned with
an available IP address

B Confirm the IP address and the Subnet Mask.
Verify that both the IP addresses and Subnet Masks of your computer and the
printer are correct and located on the same network.
For more information on how to verify the IP address and the Subnet Mask,
contact your network administrator.

B Confirm your IP address, Subnet Mask and other network settings in
[Communication Settings] in the Printer Setting Tool.
See Change the Printer Settings on page 48.

Your previous printing job failed

B [f the failed printing job is still in your computer's print queue, delete it.

Example (Windows 7): Click [Start], [Devices and Printers] and select the
printer from [Printers and Faxes]. Double-click the printer's icon, and then
select [Cancel All Documents] in the [Printer] menu.

The printer is not connected
correctly to the network

Check the WLAN icon on the LCD.

-
o

. ))
. )))

The printer is already connected some wireless network. Check
the wireless network information and confirm to connect your Wi-
Fi access point/router correctly.

) )

.= : The printer is searching for the network. Make sure the Wi-Fi
access point/router is available and wait a while. Then the printer
is still not connected, set up the printer's Wi-Fi connection again.

No icon :  The wireless network feature on your printer is off. Make sure that
the printer is in the mode you want to connect to.

| have checked and tried all the
above, but my printer does not
print.

Uninstall the printer driver and the software, and then reinstall them.

Security Software Problems

Problem

Solution

You did not choose to allow
access when the security alert
dialog box appeared during
either the standard installation,
BRAdmin Light installation, or
when printing

If you did not choose to accept the security alert dialog box, the firewall function of
your security software may be rejecting access. Some security software might
block access without showing a security alert dialog box. To allow access, see the
instructions of your security software or contact the manufacturer.

Incorrect port numbers are being
used for the Brother network
features

The following port numbers are used for Brother network features:
B BRAdmin Light = Port number 161 / Protocol UDP

For more information about how to open the port, see the instructions for the
security software or contact the manufacturer.
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Troubleshooting

Check the Operation of Network Devices

Problem Solution

The printer and Wi-Fi access Make sure you have confirmed all instructions in Overview on page 160.

point/router are not turned on

| do not know my printer's Check [Communication Settings] in the Printer Setting Tool.

network settings, such as the IP | g0 Change the Printer Settings on page 48.

address

The printer is not connected Check the WLAN icon on the LCD.

correctly to the network. R The printer is already connected some wireless network. Check
the wireless network information and confirm to connect your Wi-
Fi access point/router correctly.

PR IR The printer is searching for the network. Make sure the Wi-Fi
access point/router is available and wait a while. Then the printer
is still not connected, set up the printer's Wi-Fi connection again.

No icon The wireless network feature on your printer is off. Make sure that

the printer is in the mode you want to connect to.

Problems with Battery Charger (Optional)

If you experience any problems that you cannot resolve, please contact the reseller where the product was

purchased.

Problem

Solution

The charge indicator turned off, but the battery
has not fully charged.

Charging stopped because the battery became too hot or too cold.
Please wait and try charging the battery later.

The charge indicator flashes orange.

An error occurred during charging.

B Wipe the charging terminals of the charger and the battery with
a dry cloth.

B Replace the battery with a new one.
B Wait and try charging the battery later.
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Troubleshooting

Problems with Charging Cradle (Optional)

If you experience any problems that you cannot resolve, please contact the reseller where the product was

purchased.

Problem

Solution

The charge indicator turned off, but the battery
has not fully charged.

Charging stopped because the battery became too hot or too cold.
Please wait and try charging the battery later.

The charge indicator flashes red.

An error occurred during charging.

B Wipe the charging cradle terminals of the charging cradle and
the battery with a dry cloth.

B Replace the battery with a new one.
B Wait and try charging the battery later.

The printer does not turn on when placed it on the
charging cradle.

B Set the printer on the charging cradle correctly.
B Check the AC adapter is correctly connected.
B Reconnect the AC adapter.

The printer does not print via a USB cable.

B Set the printer on the charging cradle correctly.
B Connect a USB cable correctly.

B |f USB cables are connected to the printer and the charging
cradle simultaneously, disconnect the one connected to the
printer, turn the printer off and turn on again.

B (RJ-4250WB only) Select the correct driver in the Devices and
Printers. If the charging cradle is connected, your operating
system will also display a copy of the printer driver icon (for
example: Brother RJ-4250WB (Copy 1)) in the Devices and
Printers. Make sure it is not selected.

Problems with the Linerless Platen (Optional)

Problem

Solution

The print quality is poor.

B [nstall the Linerless Platen correctly.
B Clean the print head.

The printer does not feed paper.

B Install the Linerless Platen correctly.
B Set the roll correctly.

B Check if a label or adhesive has stuck under the roll
compartment cover. If so, clean the inside of the cover.

The media is jammed.

B Install the Linerless Platen correctly.

B Wipe any adhesive residue left along the ejection path of the
paper.

B Try using a different roll (with a weaker adhesive).
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Troubleshooting

Error Messages from the Printer

Error Message

Cause/Remedy

No Template Selected

B There is no template with the specified number.
Specify the correct number.

B When printing a template, an error is indicated if the specified template does
not exist.

B The template was not transferred. Register the template with the specified
number to the printer.

Invalid Database Record

B An error will occur when printing a template which specifies an incorrect key
code, or a non-existent key code in a linked database.

Media Error! Check Loading

B |s the correct roll installed?

Check that the correct media, for example, type (die-cut label or continuous
length tape) and die-cut label size, is installed.

B |s the roll installed correctly?

If not, remove the roll, and then reinstall it. For details, see Insert the Roll
on page 26.

B Is enough of the roll remaining?

If not, install a new roll.

Cover Open Close Cover

Is the roll compartment cover open?
Check that the roll compartment cover is closed.

Communication Error

B Transfer of the data failed. When sending a template as a .blf file, an error
is indicated if the model name in the file is different.

B Has the wireless LAN or Bluetooth connection been interrupted?

Turn the printer off and on again.

WPS did not connect Try to
connect again

The Wi-Fi access point/router could not be found.

Mass Storage Operation
Error!

Is the printer in mass storage mode?

B The printer's file system may be corrupted, or a file's name or contents were
changed while the file was being transferred or processed. Turn the printer
off and then on again.

B Do not access files on the printer during mass storage processing to avoid
further problems.

Recharge Battery!

Does the rechargeable battery have a low charge?

Use the AC adapter and AC power cord to connect the printer to an electrical
socket, or use the car adapter to connect the printer to a DC power socket to
charge the battery.

System Error!

XX

If the error message is displayed, contact Brother customer service.

Memory Full!

B Print jobs exceeding 3 m and incompatible files cannot be printed.

B Make sure the data you transfer does not exceed the capacity of the user
storage area.
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Troubleshooting

Error Message Cause/Remedy

ChargingError Cannot Charge |Is battery charging incomplete despite continuous charging?

Confirm that the battery is correctly installed. If charging still fails to complete,
the battery may be deteriorated. Replace the battery with a new one.

High Temp! Is the printer temperature too high?

If the printer overheats when the Linerless setting is enabled, wait until the
printer cools down and then try printing again.
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